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Introduction

Welcome to 3DF Zephyr

3DF Zephyr allows you to reconstruct 3D models from photos automatically. The process is
entirely automatic, and no coded targets, manual editing or special equipment are needed.
3DF Zephyr is built on top of our proprietary, cutting-edge, reconstruction technology. 3DF
Zephyr comes with a user-friendly interface, and the possibility to export in many common
3D formats or even to generate lossless video without the need for external tools.
Furthermore, 3DF Zephyr has a lot of advances functionalities, and you can, for example,
edit your models, create true orthophotos, digital elevation models (DTM), manage laser
scan data and calculate areas, volumes, angles, contour lines, and much more. 

Here in 3Dflow, we worked hard to build up both the core technologies and the user
interface. The obtained solution is in all probability the most accurate, completely
automatic, best engineered multiview-stereo algorithm available on the market. 
 
If you need further help, if you would like to request features or if you want to discuss the
product and the technology behind it, please remember that our forum
(http://forum.3dflow.net) is always willing to receive new users.

Before starting, you might want to read some hints and tips on how to take the 'correct'
photos and an overview of the reconstruction process.

If you prefer you can also jumpstart and directly Start a new Project.

Moreover, please note that there are also free online tutorials available, featuring demo
datasets you can download and more in-depth tips and tricks: our tutorials are available at
the URL http://www.3dflow.net/it/technology/documents/3df-zephyr-tutorials/

At the URL www.3dflow.net/account there’s the opportunity to create your own 3Dflow
Account: with these credentials you can access both to your private area and our forum.
In the private area you can open support tickets, submit a bug report, request a beta key
and manage the licenses tied to your specific email. From this area, if necessary, you can
also deactivate autonomously your license: all you will need to do is to reset the license
remotely and activate it on another computer.

System Requirements

3DF Zephyr is a computationally demanding application. It takes advantage of all available
CPU cores, and it makes use of the Nvidia CUDA technology where available. Please note
that a CUDA enabled Video Card can drastically improve performances (multi GPU
configurations are supported as well in Lite and Full versions). We also suggest exiting all
running applications when performing a reconstruction with 3DF Zephyr.

Minimum System Requirements:
OS: Windows 11/10
Processor: Dual Core 2.0GHz or equivalent processor
Memory: 16GB System RAM
Hard Disk Space: 10GB free HDD Space
Video Card: Direct X 9.0c compliant NVIDIA video card with at least 1GB of RAM

http://forum.3dflow.net
http://www.3dflow.net/it/technology/documents/3df-zephyr-tutorials/
http://www.3dflow.net/account
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Recommended System Requirements:
OS: Windows 11/10
Processor: Quad-core Intel or AMD CPU
Memory: 32GB System RAM
Hard Disk: 20GB free HDD Space - SSD drive
Video Card: Direct X 9.0c compliant NVIDIA video card with at least 2GB of RAM and
CUDA capabilities >= 3.0

Versions

3DF Zephyr is the complete photogrammetry software solution.

Since version 5.0, the old "3DF Zephyr Pro" and "3DF Zephyr Aerial" versions have been
merged into one single version, called "3DF Zephyr". Please contact support@3dflow.net
for any question you may have!

Our two additional flavors, "3DF Zephyr Lite" and "3DF Zephyr Free" remains the same.

3DF Zephyr is the complete photogrammetry software solution dedicated and designed
for topography, urban monitoring, natural hazard, mining, UAV, precision agriculture
applications, architecture, archaeology, medicine & dentistry, body scanning, vfx and much
more.

3DF Zephyr Lite/3DF Zephyr Lite Steam Edition is a commercial solution aimed at
small businesses, artists or in general to those users who just want to obtain a 3D mesh
and/or those who don't need all the tools available in the complete edition.

3DF Zephyr Free is a completely free edition, excellent for sharing your project files with
customers, friends and colleagues. Although it has serious computation limitations (for
example,a maximum of 50 pictures can be used) it is still a great viewer and the perfect
way to learn the ropes of photogrammetry.

3DF Zephyr and 3DF Zephyr Lite require online activation. 3DF Zephyr Lite Steam Edition
must be run through the Steam application.

3DF Zephyr also comes in an education version, with the same functions and features but
without a commercial licensing. 3DF Zephyr Education is dedicated to students, teachers
and schools.

For an updated feature comparisons list, you can refer to the following page:
https://www.3dflow.net/3df-zephyr-feature-comparison/

Activation

3DF Zephyr, 3DF Zephyr Education and 3DF Zephyr Lite editions require online activation
(3DF Zephyr Lite Steam Edition will work through the Steam Application by Valve and does
not require a product key).

The product keys are supplied by email at the moment of purchase. If you lost your product
key, please get in touch with our technical support so that we can resolve your issue.

You can activate your software either during installation or on the first run.

mailto:support@3dflow.net
https://www.3dflow.net/3df-zephyr-feature-comparison/
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The activation process will bind the product key to the computer. 

You can activate your key on as many computer as you need, as the license is floating:
upon startup and shutdown, Zephyr will obtain and release a lease so you can safely install
and use Zephyr on multiple machines within your organizations. An internet connection is
required.

If you have problems regarding online activation or deactivation, please email
support@3dflow.net - a manual offline activation process can also be issued in special
cases.

Documentation

3Dflow put a lot of effort into making make Zephyr's interface as user-friendly as possible.
However, if you want to get the best results, please spend a few minutes reading the hints
and tips you will find in this documentation.

This guide is intended for all the different versions of 3DF Zephyr unless stated otherwise.

In the next section, we will quickly review the reconstruction process. It is not essential to
fully understand the "magic" behind Zephyr, but a quick review of the main concepts can be
useful.

A Quick Overview

Here in 3Dflow we are, first and foremost, Computer Vision researchers. Computer Vision
is, generally speaking, the science that studies how to extract (any kind of useful)
information starting from images. This is a very rough definition and many subproblems
can be delineated and many different meanings for the concept of "information" can be
given. Extracting three-dimensional models from a number of images (extracting 3D
information from a 2D input) is a well-studied problem in Computer Vision. 3DF Zephyr
represents a highly refined and well-engineered solution for this problem.
 
There are three main phases in Zephyr:
· Starting a new project and defining the camera pose - this is also referred as 'Structure

from Motion'

mailto:support@3dflow.net
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· Generating 3D model
o Extracting a Dense Point Cloud - this is also referred as 'Multi-View Stereo'
o Extracting a Surface

· Extracting a Textured Mesh

When starting a new project the software will extract the camera external parameters
(positions and orientations) and their internal parameters (i.e. the focal length and other
camera properties). All the magic of this phase is done by Samantha, our leading Structure
from Motion Technology. If you want to input the internal camera parameters manually
instead of letting Samantha estimate them, you can.

After the cameras have been oriented, you can proceed and generate the 3d model. This
step goes through two phases :

- Extract a dense reconstruction. The process requires the input cameras to be correct. If
you believe a camera is not correctly oriented, you can remove it from the workspace.
Before proceeding you can also restrict or expand the volume of reconstruction. The
densification stage is managed by Stasia, our Multi-View Stereo technology, powers the
reconstruction process.  You can create different dense reconstructions (with varying
parameters) and save them into the workspace.

- Create a triangular mesh, starting from a dense reconstruction. Based on what you are
going to reconstruct you can choose from either the generation of a smoothed surface
(when dealing with human body or terrains for instance) or the generation of a sharp
surface that more benefits scenes such as buildings or mechanical parts. The latter kind of
surfaces are handled by Sasha, the meshing algorithm developed by 3Dflow.

Every mesh polygon gets textured using the most appropriate pictures according to their
visibility and quality. Within the texture generation phase there is a color balance algorithm
as well, that allows the user to select and set-up the best color for each pixel automatically
by checking the different lighting changes on the photos.

In the next section we will give some hints and tips on how to take the right photos.

Photography Guide

In this section we will list some tips to obtain good reconstructions. 3DF Zephyr is
completely automatic but does require some forethought to produce the best results.

Camera sensors.

Please bear in mind when picking your gear:

http://samantha.3dflow.net
http://stasia.3dflow.net
http://www.3dflow.net/technology/


3DF Zephyr

8 / 179

· camera performance is not determined by its megapixel resolution;
· high-end cameras do not always lead to better results;

A good camera must allow full light management in order to control each exposure value.
That is why DSLR cameras (colloquially also referred as "reflex") are usually
recommended even though also mirrorless cameras and bridge cameras can fulfill that
need.

The camera sensor is the crucial factor and the following hints may be helpful:

· Pixel size must be higher than 2 µm; therefore it is strongly recommended to use a
camera with a sensor bigger than 1/2.3" even though smaller sensors may be used
depending on the accuracy you want to reach;

· Pay attention to pixel size rather than pixels count for each picture. For instance, if a 36
megapixel full-frame reflex (35.9 x 24 mm) is being used it is advisable to shoot at a
lower resolution than the maximum provided. It is better to get bigger pixels in the
images even though fewer;

Lenses.

Every survey has its own features and conditions so choosing the most suitable lens
depends on both environmental conditions (light, obstacles on field, user movement
capability) and features of the survey subject/scene. The following tips are provided to pick
the proper photographic gear:

· Full-frame cameras: use lenses with a focal length between 25 and 50 mm;

· Cameras equipped with an APS-C sensor or with a lower sensor size: use lenses with
focal length values between 18 and 35 mm, considering a crop factor value between
1.5 and 1.6;

It is strongly recommended to keep shooting the same focal length for all the pictures you
take. Even if Zephyr can handle several kind of cameras and lenses at the same time and
in the same project, you can get better and faster results if working with a consistent set-up;

Shooting techniques.

The techniques for capturing images need to be adapted depending on the subject matter
and situation. Below are some suggestions for common situations.

Parallel axis capture
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Use this technique with planar or regular surfaces in application fields such as architecture and
aerial photogrammetry. White triangles indicate the camera positions and their field of view.

Convergent axis capture

Use this technique when it is possible to move around the subject/scene

Interiors capture
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Use this technique when capturing interiors.

If a small or medium size object is to be fully reconstructed it is possible to keep the
camera in a fixed position (on a tripod for instance) and to put the object on a turntable.
Then 3DF Masquerade will enable the background in the pictures to be hidden.

General rules.

· Keep the subject in the center of the frame;
 
· Avoid direct light sources that may cast shadows and hide surface areas;

· Avoid high ISO values since the noise may adversely affect the Structure from Motion
phase in Zephyr;

· Keep high aperture values (f/8 - F/16) when possible, as it helps get a wide depth of
field on pictures;

· Avoid blurry photos. Using good quality cameras as well as having good lighting setup
can help. Consider also using a tripod if necessary.

· Have lots of overlap between each photo (70-80%). This is probably the most important
tip. Shoot as many photos you can. Each part of the scene you're shooting should
appear in at least three separate views taken from different locations. This is a
minimum requirement, taking more photos will probably improve the final results.

· Limit the angles between photos. When moving around objects, try to keep the angle
between each photo very low.

· Shoot scenes with lots of detail and texture. The visual texture in the photos is what ties
them together. 3DF Zephyr does not work well with uniform or highly repetitive texture
and does not work at all with specular or transparent objects. You can, however, mask
out certain areas using 3DF Masquerade (bundled with 3DF Zephyr).

· Don't try to adjust lens distortion as that error is quite essential during the first phase of
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Structure from Motion;

· Even if 3DF Zephyr can deal with different cameras or lenses within the same dataset,
you will obtain better results by using the same camera with the same focal length.

· The more photos you take, the better results you will get: having redundant information
will help Zephyr. 

Remember that you can use the Image Quality Index inside Zephyr to check the status of
the pictures you are working on.

The Main Window

When opening Zephyr, the interface layout will look like this:

On the upper side, the menu bar and the toolbar give you access to all the basic actions
and functionality of Zephyr.

The Render window at the center lets you navigate through the 3D scene. You can also
right click on it to open a contextual menu to perform specific actions.

The other windows are completely "dockable"; this means you can move and dock them in
any part of the main window. To hide or show a specific dock use the View menu.

An optional toolbar can also be shown at the top or bottom of the 3D scene. This toolbar
can give quick access to picking and measurement tools (not available in 3DF Zephyr Lite
and 3DF Zephyr Free).

3DF Zephyr always saves and loads the interface layout of your last run. From Tools >
Options > Application > Restore Settings you can restore the factory default settings
(including the interface layout).
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On the left side, in the Project tab you can review all the objects currently loaded in the
workspace. The Objects are divided into 4 categories: cameras, sparse point cloud, dense
point clouds and meshes. You can remove, rename and edit every object by right clicking
on them and selecting the specific action.

The Navigator tab helps you navigate through workspaces.

On the left side you can find the Animation tab, where you are able to create and export
video animation of your 3D models.

On the right side there are the Control Points tab, the Measures tab, the Registration tab,
and the Editing tab as well.

On the same tab, the History tab lets you review, undo and redo the performed actions.

The Navigation bar is located at the bottom alongside the thumbnails of the photos loaded
in Zephyr and the Log panel.

Starting a new project

Got the photos? Then you are ready to begin the reconstruction process!

To create a new project, just click on Workflow > New Project (1) . The Project Wizard
(2) will guide you through the picture import and the camera orientation phase setup.

You can pick the 3D reconstruction phase(s) you want to run - in addition to the camera
orientation phase - by clicking the related icons in the "Computation steps" section (3).
For instance, if you enable the "model" icon, the software will complete the sparse point
cloud, the dense cloud and the mesh generation before stopping and letting you select the



3DF Zephyr

13 / 179

textured mesh generation.

If you don't need to import control points, camera coordinates or image masks, simply click
the "Next" button to go through the wizard.

The "Additional Imports" section (4) allows for importing and dealing with image masks,
control points (2D and 3D coordinates), and camera coordinates.

The "Photos selection" page will follow: it is possible to drag 'n' drop the files - or related
folder(s) - into the window or click the "+" button to select the desired path. You can also
add a specific directory including the pictures.

You will likely use JPG or PNG files, but you may also use raw file formats such as NEF,
CR2, ARW2, etc. Please, remember that raw files are generally slower to load.
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The "Import pictures from video" tool will extract a number of frames from the video file
you have selected. These frames will go through the same process as the one for standard
images.

This tool allows for setting:

- the frames output format (.png, .jpg);

- the frame rate (fps) to be extracted;

- the blurriness filter to discard low-quality frames;

- the similarity threshold to discard too akin frames;

 Also, it's possible to cut those video parts you don't want to consider during the frame
extraction.

The "Import from panorama picture" tool will split each imported 360° picture in six
equirectangular images. Once the pictures have been imported, users can pick the sides
of the pano pictures to extract by clicking the "plus" button. They can also set the field of
view of the equirectangular pictures.
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Once you have selected the data you want to process, click the Next button to get to the
Camera calibration page. You will notice a list of the pictures you have imported and their
calibration recap that 3DF Zephyr - and its Structure from Motion algorithm specifically - will
leverage.

You can select/deselect the pictures by clicking on their name or right-clicking the window
and picking the desired option from the menu.

From this page, you can Add a New Calibration or eventually modify the Calibration
that 3DF Zephyr has automatically selected.
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Zephyr is 100% auto-calibrated, so in most cases you don't have to do anything at this
point. However, you can click the "Modify Calibration" button if you have previously
calibrated your camera equipment.

In the Modify Calibration page, you can select what camera setup will be edited (if the
loaded pictures have been taken with different cameras/lenses), and define the camera's
internal parameters.
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You can load calibration files (.txt, .xml) created with an external application or the 3DF
Zephyr calibration tool (Utilities > Images > Camera calibration), by clicking the "Import
parameters from file" button.

By clicking the "Import parameters from calibration manager" button, you can import
the camera parameters you have previously loaded in the Camera Calibration Manager
tool (Utilities menu).

TIP: If you have imported wide-angle or fish-eye pictures and have issues with the camera
orientation phase, enabling the "Adjust tangential distortion parameters" option is
recommended.

Once the calibration step has been completed you simply need to set up and run the
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camera calibration phase.

Setup multi-camera groups

These functions are not available in 3DF Zephyr Lite and 3DF Zephyr Free.

Stereo Cameras group/rig relationship parameters (translation/baseline and rotation) can
be specified during the new project creation. Zephyr will organize the images in linked
groups with the possibility to change the groups or insert custom parameters.

To start this workflow the "Setup multi-camera groups" check-box should be activated on
the first page of the New Project Wizard. 

Note: Zephyr can recognize automatically the camera relationship from Leica Blk3d
devices.

On the Photo Selection page, click the "Add Directory" button to include multi-camera
folders. Then, proceed by clicking the "Next" button. Zephyr can automatically identify the
dataset folder structure and it will prompt the following message: "It appears that images
are grouped in folders. Would you like to link them?"  press 
Pressing the following buttons:

YES  will create automatically groups on the base of the directory structure.

NO  will allow to create the groups manually in the next page.

Setup multi-camera groups manually

In the case that the pictures are all in the same folder or you pressing NO button in the
previous prompt windows will be possible to create the reference and camera groups
manually.

In the Ungrouped window, it's possible to select the image's amount taken by the first
camera and click the "Move right" button"  for creating the Reference group.
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Selecting the "Add New Group" tab will generate additional camera groups for adding the
remaining images captured by other cameras. It's important that each image folder must
contain the same number of images to establish these groups.

Within each group, you'll have the option to configure relationship parameters associated
with the Reference group.

Setup multi-camera groups wizard
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Reference group and other groups of cameras can be set with two different type of
relations:

1) Translation + Rotation

2) Distance + Rotation

In both types of options, you can enable the flag and adjust parameters such as XYZ axis,
distances, and accuracy. Enabling the Rotation flag will allow to modify rotation angles if
necessary.

Using distance constraints between camera groups

Configuring the relationship with the reference group using both Distance+Rotation
enables you to utilize the distance between camera groups to scale the project.
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In the "Distance (m)" field, you can specify the distance between the cameras, for example,
1 meter, and set the desired accuracy. Afterward, click the "Next" button to generate a
sparse point cloud.

Using translation constraints between camera groups

In the "Translation (m)" field, you can specify the the x-y-z translation that bring the selected
group to the reference camera. The accuracy for each axis can be also specified.

Using rotation constraints between camera groups

In the "Rotation (deg)" field, you can specify the the rotation (in degrees) along the axis X-
Y-Z that bring the selected group to the reference camera. The accuracy for each angle can
be also specified.

Import Constraints

These functions are not available in 3DF Zephyr Lite and 3DF Zephyr Free.

As part of the workflow for creating a new project, constraints can be set by importing
known 3D positions from external control points and geographic positions from images. To
do this, the "Define constraints" check-box should be activated on the first page of the
New Project Wizard. 

Note: camera position constraints with RTK coordinates will be recognized automatically.
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The Import Constraint page will follow the Camera calibration page.
In the page's upper section, it's possible to open different tools for control point
management.
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Add control points from photo (1): 

This tool allows the placement editing of 2D image coordinates, picking control points
directly from the photos.

For the scaling process, you must place each control point on at least three pictures. It is
also advisable to pick the control point on as many pictures as possible if you plan to
leverage control points to adjust the camera positions using the Bundle Adjustment
optimization.

The use of this feature is suitable for dealing with small/medium number images and in
special cases where you want to improve image orientation by providing more data to the
3DF Zephyr SFM algorithm. 

Import control points from file (2): 

It opens the import control point tool for importing  2D image coordinates from text or csv
files.
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This feature is advisable when you have already created project 1 with oriented images
associated with spatial coordinates and want to use them in project 2 to improve the
orientation of cameras in special cases. If you are also dealing with huge datasets and/or
large numbers of control points, then you can import GCPs at once rather than scrolling the
whole set of images again; it may be way more time-saving.

Find markers in photos (3):
It opens the Detect marker tool for finding automatically markers placed in the scene.

Export control points to file (4):
This function allows to export 2D image coordinates associated with Ground Control
Points (GCP) to a text or CSV file, creating a *ControlPoints2D.txt file. Each line defines a
GCP as a 2D image coordinate:

"GCP1" "IMG_3319.jpg" 4.33473658e+03 2.24061730e+03
"GCP1" "IMG_3320.jpg" 3.30352087e+03 2.42468881e+03
"GCP2" "IMG_3319.jpg" 3.01642756e+03 3.16114630e+03
"GCP2" "IMG_3320.jpg" 1.68567672e+03 2.14786953e+03

The middle section it features the constraint tab.
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The Constraint type filter (5) allows to change the view to

- Camera: this option allows viewing the GPS coordinates of each image.

- Control point: this option will allow the display of the imported constraints from an external
source.

Pressing "CTRL+A" will allow selecting all the tab rows, and "Right-click" with the cursor
will allow you to change Reference system and Accuracy for each camera or control point.

Constraints and Check Points column (6)

Each control point can be set as Checkpoint (to measure the residuals), Constraint (used
in the bundle adjustment), or both by using the check-boxes on the left of each point. It's
always a good idea to include some checkpoints that are not set as constraints.

- Constraints (CS) are those points you are most confident of in terms of accuracy level,
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and 3DF Zephyr relies on them to drive the scaling process.

- Checkpoints (CK) are references that the software only considers while scaling to
monitor the error value.

Load GPS position from Exif (7)

This button import camera positions by loading them from Exif information and using them
as constraints.
A common scenario is when loading information from images taken by drones or UAV
systems that record the GPS coordinates of the shots in Exif data.

Import constraints from a file (8)

this function allows directly set constraints from a text or .csv file via the "Import constraints
from file" button; the imported coordinates and the GCPs you have added to the project
must have the same name/label.

Coordinates should be defined using the following syntax:

"Control_Point_1" 8.18880729e-01 -5.14516149e-01 4.54143586e-01
"Control_Point _2" -5.64690812e-01 -5.65085273e-01 1.09244112e+00

Note: control points coordinates can be selected and imported after creating a sparse
point cloud from the "Align model with 3D constraints" menu.

The lower wizard's section displays the Target reference system and the Bundle
Adjustment check-box.

The Reference System can be changed by clicking on it and choosing the Select
reference system option from the drop-down menu.

The Projection Coordinates System window will be open:
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It's possible to select the new coordinate reference system from the 3DF Zephyr database,
or import a new one from an external source by clicking the "Import" button and clicking
"OK". 

Optionally, a Geoid Gravity Model can also be loaded in relation to the Coordinate
Reference System. 

Bundle Adjustment check-box

It's possible to enable/disable the "Perform Bundle Adjustment" option to optimize the
camera positions, and minimizing the reprojection error of the control points you have
added to the project. The slider will allow setting the global confidence weight for the
control points used as constraints.

https://www.3dflow.net/wp-content/uploads/2021/11/Projection-Coordinates-System_ENG.png
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Cameras orientation

The first phase of 3D reconstruction is called Structure from Motion and computes the
position and orientation of each photo loaded in Zephyr. This step results in a sparse point
cloud.

Users must define the Category depending on the scenario/subject they have captured,
and select the Preset according to the accuracy and quality level they want to achieve on
the 3D model(s).

You can switch to the Advanced settings by clicking the drop-down menu in the upper
right corner of the window.
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The advanced settings are explained in detail below:

Keypoints Sensitivity: "keypoints" refers to the matched pixels in the pictures. This
parameter determines the maximum number of keypoints that are to be extracted for each
image. Please note that a substantial number of keypoints does not lead to a better
result since the more elements involved, the higher the ambiguity during the matching
phase.

Low: extracts up to 5,000 keypoints per image

Medium: extracts up to 7,500 keypoints per image

High: extracts up to 10,000 keypoints per image

Very High: extracts up to 15,000 keypoints per image

It is recommended to decrease keypoints density when:

  - the outcome is required quickly;

  - the distance between the cameras and the subject/scene does not vary;
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  - pictures have enough (at least 60%) and high (70% - 80%) overlap;

It is recommended to increase keypoints density when:

  - cameras are not oriented properly;

  - pictures are too close to or too far from the subject/scene;

  - pictures have low overlap;

  - the subject/scene has a uniform or textureless surface (e.g., a white wall);

Matching Type: controls which optimizations (if any) should be used when computing
matches between images. The "accurate" option will take longer to complete camera
orientation;

Matching Stage Depth: controls how many keypoint matches are performed on the
images. Usually, the more is the better, however, this comes at a computational cost.

It is recommended to decrease this parameter when:

 - the outcome is required quickly;

 - cameras are close to the subject/scene;

 - pictures come with good texturing and high overlap (70% - 80%);

It is recommended to increase this parameter when:

 - cameras are not oriented properly;

 - pictures are too close to or too far from the subject/scene;

 - pictures have low overlap;

 - the subject/scene has uniform or texture-less surfaces (e.g., a white wall);

Photo Ordering: this parameter tells 3DF Zephyr which capture sequence has been
leveraged onsite, thus speeding up the near-image detection. By using the "sequential"
option, you are telling 3DF Zephyr the pictures have been taken sequentially (photo 1 -
photo 2 -  photo 2 - photo 3 - etc.), while the "circular" option hints at a closed loop
sequence.

If you don’t know the photo order, pick the “unordered“ option. The last "approximate
grid" option is designed for nadiral aerial datasets.

Tie-points quantity: this value affects the number of points to be considered during the
Bundle Adjustment optimization. A higher value can lead to better results and a higher
computational cost.

Reconstruction Engine: 3DF Samantha supports both incremental and global
reconstruction pipelines. The global pipeline tries to solve the orientation problem globally,
which means that it's usually faster than the incremental one and potentially less prone to
drifting error. The incremental engine on the other hand, albeit slower, tends to include
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more cameras in the final solution. In a nutshell, you are supposed to use the global
pipeline if you are processing a huge dataset (more than 1000 pictures).

Bounding box method: it defines the computation method of the bounding box. It's
recommended to keep the default option "discard outliers", namely the far points that are
not relevant to the 3D reconstruction.

A further description of those parameters is available here: http://www.3dflow.net/3df-
zephyr-parameters-tuning-guide/

From the "Settings" drop-down menu, you may also select the "Custom" mode. This
mode allows you to fine-tune in detail every single reconstruction parameter. Remember
that you can load an XML file or reset the values to default settings by right-clicking and
selecting the desired option. Please note that a hint related to the selected parameter is
shown at the bottom of the window.

Once the camera orientation phase has been completed, the sparse point cloud will
appear in the workspace as well as the oriented cameras identified by blue pyramids
whose size and color are editable from the Options menu.

http://www.3dflow.net/3df-zephyr-parameters-tuning-guide/
http://www.3dflow.net/3df-zephyr-parameters-tuning-guide/
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ACCURACY EVALUATION OF CAMERAS ORIENTATION PHASE 

Once you are done with the first 3D reconstruction step, it is advisable to check its
accuracy in order to figure out which pictures should be discarded to decrease the error
even on further phases.

By clicking on Tools > Workspace > Camera Stats the following chart will appear:  

The two columns on the right show the Mean reprojection error for each picture and the
Points, namely the number of keypoints (the points for which the software retrieved the
position) detected in each photo. By clicking on the entries "Mean Reproj. Error" and
"Points", users can sort the values in decreasing or ascending order.
 
Overall, a well-oriented picture with a good accuracy degree results in a low reprojection
error and a number of keypoints. Keypoints represent the equations amount exploited
during the reconstruction phase, so their high value is related to the higher reliability of the
final result. It's worth noting that the reprojection error gives a rough idea of the orientation
accuracy since it should always be related to the sensor size of the camera.

The bounding box

When the sparse point cloud has been created, the bounding box will be computed as well.
The bounding box corresponds to the volume in which all points that do not fall into said
volume will be discarded in the next 3D reconstruction steps.

You can then change how Zephyr behaves by editing the bounding box settings (not just for
"what" is being reconstructed, but also the discretization level changes when the volume
changes too).

You can enable the bounding box visualization - and edit it - either from the Scene menu or
by clicking the related icon in the top toolbar.
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Once enabled, the bounding box will be visible in the 3D viewport and the bounding box
edit widget will appear on the screen. You can toggle the bounding box controls using this
widget.

We suggest to enable - and adapt if need be - the bounding box as soon as you complete
the sparse point cloud generation. This way you are aware of what will be affected in the
next 3D reconstruction steps.

Translate: click and drag the desired gizmo to move the bounding box over the selected
axis.

Rotate: click and drag the desired gizmo to rotate the bounding box over the selected
rotation axis.

Scale: click and the desired face of the bounding box to scale the bounding box.

Reset/smart reset: resets the bounding box (the smart reset will try to automatically fit the
bounding box to the computed point cloud).

Adapt: it allows to adapt the bounding box to one of the objects in the workspace (sparse
point cloud, dense point cloud, mesh, etc.).

Always show the bounding box: keeps the bounding box rendered in the scene even when
the bounding box widget is closed.

3D Model Generation

To start the process, simply click on Workflow > 3D Model Generation or click on the
corresponding icon in the toolbar after the camera orientation phase has been completed.

http://www.3dflow.net/3df-zephyr-parameters-tuning-guide/
http://www.3dflow.net/3df-zephyr-parameters-tuning-guide/
http://www.3dflow.net/3df-zephyr-parameters-tuning-guide/
http://www.3dflow.net/3df-zephyr-parameters-tuning-guide/
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Tip: Before starting the 3D model generation, it is advisable to set the 3D reconstruction
volume by editing the Bounding Box. This step is an optional one as the bounding box is
automatically generated. By adapting the bounding box, you can improve the results and
speed up the computation time.

The first page of the 3D model generation wizard allows to pick the cameras to be used for
the dense point cloud creation. You will notice the "All cameras" option is enabled by
default, however, you can select a subsample of pictures choosing the "Select cameras"
or the "Select cameras by tag" options. You can also manually select the cameras in the
workspace by first using the camera selection tool from the Editing panel. Click the
"Next" button when you are done.

Like the first 3D reconstruction step, the dense point cloud creation and the mesh
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generation phases can also be set using categories and presets, advanced or custom
modes.

While categories and presets are described below, for the advanced settings please refer
to this document for the dense point cloud generation, and this document for the mesh
creation.

Dense point cloud categories

- General: works in most cases, to be picked even when you are undecided about which
category to use.

- Aerial - Nadiral images: use this category when you are reconstructing a top-down view
scenario, typically a UAV dataset.

- Urban: use this category if the pictures have not been taken from the same distance from
the subject/scene, or if you have mixed different types of photos.

- Human Body: use this category when you are scanning human body parts, including
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closeups or full figures.

- Surface Scan: use this category to reconstruct flat surface closeups, like terrain or
ground.

- Vertical Structure: use this category to reconstruct BTS / telecommunication towers or
other thin vertical structures from UAV pictures.

Dense point cloud presets

- Preview: this preset skips the Stereo phase and uses the sparse point cloud as the
dense point cloud.

- Default: to be used in most cases.

- High details: higher resolution, slower but produces a more dense point cloud.
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Mesh generation categories

- General: works in most cases, to be used even when you are undecided about which
preset to use.

- Aerial - Nadiral images: use this category when you are reconstructing a top-down view
scenario, typically a UAV dataset.

- Urban: use this category if the pictures have not been taken from the same distance from
the subject/scene, or if you have mixed different types of photos.

- Human Body: use this category when you are scanning human body parts, including
closeups or full figures.

- Surface Scan: use this category to reconstruct flat surface closeups, like terrain or
ground.

- Vertical Structure: use this category to reconstruct BTS / telecommunication towers or
other thin vertical structures from UAV pictures.

- Laser Scan: Use this category to extract meshes from laser scans point clouds.

Mesh generation presets

- Preview: default settings with no photoconsistency optimization.

- Default: to be used in most cases.

- High details: increased resolution during photoconsistency, slower but produces a mesh
with more polygons.

Once you have defined the above settings, you can click the "Next" button first and the
"Run" button afterward.

The dense point cloud generation places the greatest demands on hardware capabilities
along with the camera orientation phase.

Remember that you can reconstruct and add more dense point clouds and meshes in the
same Zephyr project, even leveraging different parameters or reconstruction volumes.

Texture generation

The fourth and last 3D reconstruction step allows to run the textured mesh generation.
Simply click Workflow > Textured mesh generation.
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Like the previous 3D reconstruction steps, the textured mesh generation phase can also
be set using categories and presets, advanced or custom modes.

The first page of the textured mesh generation allows to pick the cameras to be used for
the texture creation. You will notice the "All cameras" option is enabled by default,
however, you can select a subsample of pictures choosing the "Select cameras" or the
"Select cameras by tag" options. You can also manually select the cameras in the
workspace by first using the camera selection tool from the Editing panel.

The "Use camera weights" option may be enabled if you want to assign a specific
reliability value (0.1 to 1.0) for each camera. Please, consider that weights are taken into
account along with the camera visibility for each polygon.

Click the "Next" button when you are done.
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Categories and Presets for the textured mesh generation are described below.
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Textured mesh categories

- General: works in most cases.

- Vertical Structure: use this category to reconstruct BTS / telecommunication towers or

other thin vertical structures from UAV pictures.

Textured mesh presets

- Low Poly: generates a single, low poly textured mesh.

- Default Single Texture: generates a single textured mesh with default parameters.

- Default Multi Texture: generates a multi textured mesh with default parameters.

- High details: generates a multi textured high-resolution mesh.

The below wizard will appear when selecting the "Advanced" settings from the drop-down
menu on the upper right corner:
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Max. texture size: sets the maximum size of the texture. Please note that a two-value
power is not guaranteed, as it is just a higher limit value, although Zephyr will make it a
power of two when the input images allow it to do so. Nevertheless, selecting a resize is
possible when exporting the textured mesh (see the "Export menu" chapter).

Maximum number of textures: defines how many textures will be generated.

Generate 32-bit textures: enable this texture to save as 32-bit textures. If unsure, leave
this unchecked, as it is used in specific workflows.

Max. vertices: defines how many vertices of the mesh are involved in the texture
generation.

Image resolution: sets the resolution percentage for the texture generation process.

Color balance strength: adjusts the color balance strength according to the exposure
values of the pictures.



3DF Zephyr

42 / 179

Use blurriness detection: every picture contribution for each triangle will be weighted
depending on its blurriness. That is useful when some of your photos are slightly blurred
(e.g., the picture background).

Sharpening filter: weight of the sharpness filter that should be applied to the output
texture(s).

You can see the texture UV maps by right-clicking the textured mesh name in the Project
panel and selecting the "View UV mapping" option.

UV maps are wrapped, so remember you can export a mesh, define your own UV mapping
in an external software (e.g., Blender) and re-import the mesh to generate the texture again
using your own custom UV maps from the "Import" menu ("Import mesh with UV map"
tool).

Extracting a dense point cloud

To start the process simply click on Workflow > Advanced > Dense Point Cloud
Generation or click on the corresponding icon in the toolbar.

http://www.3dflow.net/3df-zephyr-parameters-tuning-guide/
http://www.3dflow.net/3df-zephyr-parameters-tuning-guide/
http://www.3dflow.net/3df-zephyr-parameters-tuning-guide/
http://www.3dflow.net/3df-zephyr-parameters-tuning-guide/
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As of 3DF Zephyr 4.5 it is possible to access the dense cloud generation from the
"Advanced" menu if need be. Repeating the dense point cloud generation using the
generated model as an input for the dense cloud generation algorithm may yield better
results, as a consequence of applying the photoconsistency-based optimization algorithm.

Advanced parameters are explained in detail below.

· Image resolution: defines the resolution used for the pictures. A higher resolution
keeps more details, but it may produce noisy results if using low-quality photos.
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Processing time is strictly related to this parameter.

· Number of nearest cameras: the number of cameras used to create depth maps that
is also linked to the number of oriented pictures. You should increase that value if you
calculate that there are N photos for each camera that are aiming at the same point of
the scene. Increasing the number of cameras may increase the processing time.

· Speed up level: allows a speedup factor that can be determined by preemptively
discarding redundant pixels.

· Noise filtering: low values will produce much denser point clouds but with noisy areas,
whereas high values will produce cleaner clouds with fewer endpoints.

· Update Colors: updates colors once the computation is done.

· Shape from Silhouette: (feature available only in the full version of Zephyr) this is an
image-based modeling technique that uses the profile, or silhouette, of the subject to
create a virtual hull containing the subject. You must create the masks for all the pictures
before running the dense point cloud generation phase using this option. This technique
can be quite worthwhile when you need to deal with transparent or reflective surfaces
which cannot be removed with 3DF Masquerade.

· Discretization Level: this parameter defines the level of accuracy of the dense cloud
when it is extracted from masked images. Higher values will produce a more defined
dense cloud, whereas lower values might be the best choice when masks are not super
accurate.

Once you have defined the above settings, you can start the process by clicking the "Run"
button.

A further description of the advanced settings is available here: http://www.3dflow.net/3df-
zephyr-parameters-tuning-guide/

Extracting a mesh

To start the process simply click on Workflow > Advanced > Mesh extraction or click on
the corresponding icon in the toolbar.

In the new window you need to select the dense point cloud you want to use to start the
mesh generation. That is because you can create more dense point clouds in Zephyr.

http://www.3dflow.net/3df-zephyr-parameters-tuning-guide/
http://www.3dflow.net/3df-zephyr-parameters-tuning-guide/
http://www.3dflow.net/3df-zephyr-parameters-tuning-guide/
http://www.3dflow.net/3df-zephyr-parameters-tuning-guide/
http://www.3dflow.net/3df-zephyr-parameters-tuning-guide/
http://www.3dflow.net/3df-zephyr-parameters-tuning-guide/
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Advanced parameters are explained in detail below.

· Watertightness: higher values will tend to close more holes.

· Update colors: updates colors once the computation is done.

· Photoconsistency-based Optimization: this algorithm improves the mesh details
extracted by the mesh algorithm, and although it will require extra computation time, it's
generally worth using it. Usually, you can get better results if the image resolution of the
photoconsistency-based optimization is higher than the resolution used in the stereo
step. You may also run the photoconsistency-based optimization as a mesh filter from
Tools > Mesh filters. The same Photoconsistency parameters can also be found in the
context menu to the workspace window’s right, from the Editing tab > Filtering >
Photoconsistency.

· Image resolution: controls the image's scale resolution used internally by the
photoconsistency algorithm. If you already have suitable initial geometry, it is
reasonable to run the photoconsistency with a high resolution (50% – 75% ). If the input
is of poor quality, it is advisable to leave a low resolution (25%).
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· Hierarchical subdivision: if this value is greater than 0, the photoconsistency
algorithm will be sequentially applied more times, automatically adjusting the image
resolution and the iteration number. This means that the same results can be obtained
by running the same algorithm multiple times with different and appropriate settings.
More details on this setting are available at https://www.3dflow.net/tutorial-point-cloud-
and-mesh-filters/

· Reprojection area: controls the size that every triangle will try to obtain at the end of
the photoconsistency process. Given a triangle, its final reprojection area (in pixels) to
the nearest camera will tend to get near the specified value. Lowering this value will
make a denser mesh: the final mesh will then have a variable level of detail, with a
higher vertex point cloud corresponding to those areas viewed by nearer cameras. In
most cases, the default value will work well; in case you are dealing with a mesh that is
already very good (for example, one that has already finished a photoconsistency step).
This parameter can be lowered to get more detail; instead, it can be raised in very
noisy meshes and low-quality images.

· Edge filter: it is a post-processing method that can generate “fake details” by
increasing the number of mesh triangles. Depending on the result you want to obtain
and the photo’s quality, you need to carefully adjust the slider to avoid creating
additional noise instead of additional details.

· Enhance filter: this parameter is used to emphasize edges; the more the mesh is
angular (buildings, objects, etc.), the more you can increase this value. Usually, it can be
kept at a value of 0.5.

You can start the mesh reconstruction by clicking on Next and then on the Run button.

Timing may vary depending on the number of polygons you have previously selected.

You can create several surfaces in the same Zephyr project using different parameters.

A further description of the parameters above is available here: http://www.3dflow.net/3df-
zephyr-parameters-tuning-guide/

Mesh enhancement and densification

Polycount alone is never a good heuristic to understand the quality of a 3D reconstruction.
However, there are some specific workflows where it is necessary to obtain very dense
mesh (hundred millions of polygons) in order to generate displacement maps or for similar
post-processing techniques. If you are wondering why you may need such a high polygon
count, then you most likely do not need this feature and can happily skip this paragraph.

Since 3DF Zephyr 4.0, a new additional step after the textured mesh generation, called
“Generate and export enhanced mesh” is available in the workflow > Advanced menu:
this is not a photogrammetry process but rather a post processing that can lead to
what is commonly known as fake detail (for example, a drawback is that tattoos get heavily
carved in human bodies as well as plain text gets carved in papers, etc.).

This process is not aimed at engineering, science and survey users of 3DF Zephyr
or any other field where accuracy is important. Although it is more prone to high-
frequency noise, this densification process to many millions (or in very niche workflows,

https://www.3dflow.net/tutorial-point-cloud-and-mesh-filters/
https://www.3dflow.net/tutorial-point-cloud-and-mesh-filters/
http://www.3dflow.net/3df-zephyr-parameters-tuning-guide/
http://www.3dflow.net/3df-zephyr-parameters-tuning-guide/
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even billions) polygon can be useful sometimes.

Below is a simple example from a 35 photos dataset that has been enhanced from 2
million triangles to almost 100 million: on the left, the raw textured mesh and on the right,
the enhanced textured mesh. In this case, the enhanced method wasn’t very helpful as all it
did was extract more noise.

However in some cases, for example when there is a very low amount of cameras that see
the same point, this feature may extract “fake” detail that is actually noticeable (albeit some
additional noise). This is a similar example (31 images) enhanced from 370.000 triangles
(left) to 4 million triangles (right).

As a final note, the high-frequency gain is not mandatory (as it is controlled by a parameter
from 0% to 100%) so eventually, this feature can be used simply to densify a mesh or a
textured mesh to an arbitrary polycount if desired (the other densify tool already available in
Zephyr works differently and is capped to 50M points)



3DF Zephyr

48 / 179

Starting a project from a video

3DF Zephyr can work with images and video data. Although videos usually come with
lower resolution, having a continuous video feed ensures overlap, making some datasets
much easier to acquire that way. 3DF Zephyr will almost always yield better results with
photos, but it's a useful feature to keep in mind.

3DF Zephyr offers an intelligent frames extraction tool: in the new project wizard, simply
select "Import pictures from video" and the following window will appear:

Zephyr will automatically extract frames from videos (you can set a sampling rate indicated
as frames per second or simply extract all the frames of the video, based on the framerate
of this one) and treat them as normal images. Missing EXIF data is not a problem for
Zephyr, as it is 100% autocalibrated. However, providing a manual device calibration may
help, especially when dealing with fisheye lenses such as those of action cameras.

You can also enable a blurriness auto-filtering, which will discard frames that are too
blurred and an auto similarity discard filtering, which will automatically discard frames that
are too similar to each other.

The "frame queue size" is used to define the amount of memory to be used for frame
queuing.

You may use the frame preselection toolset only to select a specific video part.

Project Panel

The Project panel is located in the left sidebar of the main Zephyr interface. This panel
gathers the most important parts of the .zep file.

In the Cameras section you can find thumbnails of the images imported in Zephyr, both
those that were successfully oriented and those that failed the orientation step. By double-
clicking with the left mouse button on a thumbnail the properties window will appear with:

· information about the resolution and the position in the Zephyr coordinates system
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· internal calibration parameters
· statistics about the keypoints that Zephyr managed to find during the SfM phase and

the mean reprojection error;

By right-clicking one or more pictures it is possible to:

· try again to re-orientate the cameras that have not been orientated

· see the picture as an overlay, by changing the point of view

· see the picture thumbnail at a bigger resolution

· rotate and rename the camera thumbnail

· change the camera picture file

· change the mask linked to the camera

· open the properties window

· export external and internal parameters of the cameras;

· export the undistorted images;

The Sparse Point Cloud, Dense Point Cloud, Meshes and Textured Meshes
sections all allow users to access the properties of the reconstructed 3D object (double-
click with the left mouse button) which will show:

· statistics about the point cloud/mesh with the total number of points/polygons;

· information about the generation  process of the cloud/mesh (settings, running time,

Zephyr version, generation date and time);
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· detailed data about the reconstruction settings as they can be used in .xml files;

· the log file about the reconstruction phase;

Tip: in the sparse point cloud properties you can find the Mean Square Error which
shows the quality of the reprojection in the orientation phase. As a rule of thumb, when this
value is lower than 1 then the orientation can be considered valid and you can proceed with
further steps. With values higher than 1, you may want to execute the orientation phase
again by:

· excluding pictures with a very high reprojection error (you can find that value in the

properties of every single camera);

· adding control points on the images, exporting them, and then using them as

constraints in the first phase;

By right-clicking the generated sparse point cloud it is possible to:

· rename the sparse point cloud;

· reset the bounding box volume;

· export the sparse point cloud;

· view the sparse point cloud properties;

· Modify the order of elements in the project tab; 

By right-clicking the generated dense point cloud it is possible to:

· rename the dense point cloud, clone it or delete it;

· export the dense point cloud;

· see confidence information (3DF Zephyr Pro and 3DF Zephyr Aerial only);

· view the dense point cloud properties;

· Modify the order of elements in the project tab;

By right-clicking the generated mesh it is possible to:

· rename the mesh, clone it or delete it;

· export the mesh;

· compute the mesh volume (this feature is not present in 3DF Zephyr Lite and Free - the

value will be saved in the mesh properties);

· view the mesh properties;

· Modify the order of elements in the project tab;
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By right-clicking the generated textured mesh it is possible to:

· rename the textured mesh, clone it or delete it;

· export the textured  mesh;

· view the textured mesh properties;

The full version of 3DF Zephyr also features the Orthophoto.

By right-clicking a generated Orthophoto it is possible to select the following options:

· Open in DEM Viewer: opens the orthophoto in the DEM viewer;

· Open in Multispectral Viewer: opens the orthophoto in the Multispectral viewier tool;

· Edit: opens the Orthophoto Editor;

· Relocate: allows you to locate the orthophoto to a new pathway;

· Bands: enables viewing the orthophoto according to the selected band;

· Export: opens the orthophoto export tool;

· Rename, Clone, Delete;

· Properties;

The full version of 3DF Zephyr also features the Drawing Elements subsection including
sections, contour lines or vector graphics.

By right-clicking a generated drawing element it is possible to:

· rename the drawing element;

· change the color of the drawing element;

· export all the drawing elements or those visible/selected;

· access the drawing element properties;

Animator panel

The Animation panel is located in the left sidebar of the main Zephyr interface. This function
allows to easily create video animations of your 3D models in Zephyr and export them in
different file formats (avi, wmv, mp4) or upload them to YouTube directly.
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To manually create an animation, simply click the "Add current position" button in the
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Animator panel and move the workspace camera to the desired position(s). By enabling
the "Show keypoints" option, every (manual) keypoint position will be identified in the
workspace by a yellow frustum.

To automatically create an animation, click the "Create automatic plan" button in the
Animator panel and choose among four different animation paths (circular, spiral, panning,
fly over). Each automatic plan comes with its own settings page and the related keypoint
track will be identified by a light blue frustum sequence.

Automatic animation paths:

· Circular: circular trajectory around the target element. Radius, height, and axis of

rotation can be defined;

· Spiral: multiple orbits going up around the mesh. Basically extends the previous type,

stacking multiple circles with decreasing radius;

· Panning: movement parallel to the current view plane: the camera moves

perpendicular to the pointed direction;

· Fly Over: Smooth cascade motion on top of the mesh coming with adaptable

parameters of slope and trajectory length (useful for Aerial datasets involving nadiral

pictures);

Once the keypoints have been placed, you can either click the Play button to get a preview
of the animation or edit the single keypoint by right-clicking its name in the animator panel
and selecting the Edit option. You can also set the whole animation length using the
Duration field.

A new window will appear by clicking the Record button, allowing you to define those
settings such as the video resolution (up to 4K), the framerate, the target bitrate and the
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saving options. You can also add the 3Dflow animated logo to your animation's intro
enabling the dedicated option.

Notes:

1. Animations are scalable in time: you can choose the total length and the transition time

used to blend the new trajectory with the existing keypoints;

2. In order to easily edit the automatic sequences, the workspace 3D gizmo allows to

move the keypoints at once by setting the parameters of the wizard;

3. You can delete or edit the keypoints and part of the animation sequence. In case the

result is not as desired, you can undo any operation of the editing process;

4. You can join multiple animation sequences into a single one;

In case the trajectory comes with sharp edges along way, you may try to increase the Total

time parameter to allow a smoother interpolation.

Control Points panel

These functions are not available in 3DF Zephyr Lite and 3DF Zephyr Free.

Control points allow you to define specific coordinates; that can be used then to calculate
the distance between other points and cameras and use them as constraints for the
alignment of the point clouds or mesh.

Control points, alignment, and model scaling with known control points (or known
distances) can be managed from the panel on the right labeled GCP (Ground Control
Points), where the GCP created or imported in 3DF Zephyr will be listed with their
information.
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Coordinates Reference System (CRS) section

This section will display the current reference system used. It can be changed by clicking
the "Change" button and opening the Change current coordinate reference system
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window.

Clicking on the "Select Projection CS" option in the New Coordinates Reference
System drop-down menu, will open the Projection Coordinates System window:
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Select the new correct coordinate reference system from the 3DF Zephyr database, or
import a new one from an external source by clicking the "Import" button, and click "OK". 

Optionally, a Geoid Gravity Model can be loaded as well, in relation to the Coordinate
Reference System. This feature can be helpful if you have taken GPS coordinates in a
different reference system, which will cause a wide metric error compared to the GPS
coordinates obtained from the pictures.

To complete the reference system's change, be sure that the "Transform coordinates"
flag is checked, and click "OK" in the previous window.

Add control point section

https://www.3dflow.net/wp-content/uploads/2021/11/Projection-Coordinates-System_ENG.png


3DF Zephyr

58 / 179

These functions will allow the placement and movement of the GCPs in the project.

· "From images" Function:  Allow to add control points by picking on photos.

A much more accurate way to add control points is to pick them directly from the photos.
You need to pick the same coordinate on at least two pictures in order to triangulate and
make Zephyr calculate the control points. 

If necessary, it's possible to clear all previously created control points by right-clicking on
the point list and left-clicking "Delete All",and  "Yes" to confirm. Each control point can
also be removed individually by right-clicking on the appropriate row and clicking "Delete".

From the GCP panel, in the Add control point section, click the "From images” (1)
button: the Edit Control Points window will appear.

In the Camera list (2), left-click a picture to view it in the Control Point Picker Selector. 

Left-click where you want the control point, and an Red dot (3) will appear. A violet border
will highlight the first selected image (4), but the "OK" button won't be available yet:
remember, at least two images to define a control point in the 3D space are needed.

Click on another image in the camera list (2): this time the epipolar line will also appear
(highlighted by the color inversion in the picture), which will help to position the second 2D
coordinate by left-clicking, the available images will be highlighted by a yellow border
(5). It's possible to add as many coordinates as wanted (usually, the more coordinates the
better the accuracy) and click "OK" to complete the control point selection.

As the positions of the selected 2D points are changed, you can see the Global
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Reprojection Error and Local Reprojection Error of the control point in real time.

The Advanced Tools can provide valuable help with control point placement in the
editing window:

Advanced Tools

Fit in view: resize the image to fit in the view.

Rotate 90 degrees clockwise, counter-clockwise, reset rotation: rotate the
image and reset the initial position.

Show magnifier: show/hide the magnifier on the cursor while placing control points
on images.

Show reprojection error: show/hide local and global reprojection errors of the
current control point.

Show epipolar line: show/hide the epipolar line.

Show other points: show/hide previously placed control points.

Automatic matching on current image: automatically find and place a control
point on the current image.

 
Automatic matching on all images: automatically find and place a control point
on all the pictures

Detect marker: It automatically detects the center of a rectangular marker placed in
the scene. By clicking the "Detect marker" icon and drawing a rectangle upon the
center of the marker you want to be found, 3DF Zephyr will automatically place the
control point at the center.

Note: Using the tool with a check-board style marker will improve the automatic
detection.

 

Detect sphere: it allows to detect the center of the spheres placed in the scene. By
clicking on the "Detect sphere'" icon and drawing a rectangle over the sphere you
want to be found in the image, 3DF Zephyr will automatically place the control point
at the center.

Note: This feature is expressly designed for the forensics industry, i.e., to support
the analysis of the line of fire in crime scenes where a laser scanner scans the
spheres on the trajectory rod.

 Clear point: remove control points placed on the image.
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You can change the camera "Visibility" by selecting the "Show reprojection cameras"
option from the drop-down menu in the bottom left corner of the editing window, that's filter
will permit to place the control points on "far cameras" (dull yellow frames) as well. In
some cases, this method could improve the accuracy, especially when a few cameras
come with and a high reprojection error. The"Show picked cameras" option will shows
cameras (violet frames) where the control point is already placed.

· The "Pick" Function: allows to add control points by direct picking in the rendering
window and it's the easiest way (albeit the least accurate) to insert a new control point
from the 3D reconstruction directly.

From the "GCP" panel  go to the "Add control point" section and click the "Pick" (1)
button. The mouse cursor will be displayed as crosshair icon (+): move it on the scene and
left-click (2) the desired control point position. A new control point will be added to the
control points list (3) and will be automatically shown in the scene.

Note: This control point selection mode cannot be done on a textured mesh.
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· "Pick  Edit" function

From the same section Add control point, it is also possible to find the "Pick  Edit"
button: this function allows the user to select a control point by directly picking it on the
scene (exactly like the "Pick" function) and then modify the position of the control point by
editing its position with the "add control point from images" interface, with the control
point already in place in all the possible cameras.

Import / Export section

In this panel section will be possible to import control points from a text or csv files.

· The "Import 2D" function

Importing control points from text files allows the user to add control points exported from
3DF Zephyr, or other applications automatically: to do that, click on the "import 2D"
 button, pick the desired text file and then click "Open". A window will appear to confirm
that the import phase has been completed successfully: click "OK".

Example:for each imported control point, it is necessary to define coordinates for at least
two images. For example, to import a control point named "Point1" seen by the camera
"PictureA.jpg" at the (x,y) coordinates 100,600 and from a second camera "PictureB.jpg"
with coordinates (x,y) 200,660, the file has to be formatted in the following way:

Point1 PictureA.JPG 100 600
Point1 PictureB.JPG 200 660
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· The "Import 3D" function

This tool allows the user to define control points by using 3D coordinates directly,
without detecting any control points in images. In order to exploit this tool the 3D
coordinates must have the same reference system as the workspace where the 3D
model is being processed. Afterwards control points can be defined for each 2D
coordinate as needed.
It is necessary to specify a reference object if users want to get the metric error
between their model/cloud and the 3D coordinates.

· The "Export All" function

Next to  the "Import 3D" button it is possible to access the control point (and distances,
defined in the "Measures" tab) export function.
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From this window it is possible to export:

· 2D coordinates
It creates a *ControlPoints2D.txt file - it defines the control points as 2D
images coordinates, as:

"Control_Point_1" "IMG_3319.jpg" 4.33473658e+03
2.24061730e+03
"Control_Point_1" "IMG_3320.jpg" 3.30352087e+03
2.42468881e+03
"Control_Point_2" "IMG_3319.jpg" 3.01642756e+03
3.16114630e+03
"Control_Point_2" "IMG_3320.jpg" 1.68567672e+03
2.14786953e+03

· 3D Coordinates and 3D Constraints
It creates a *ControlPoints3D.txt\ .scr\ .dxf\ .ncn files - it defines the control points
as 3D coordinates, as:

"Control_Point_1" 8.18880729e-01 -5.14516149e-01
4.54143586e-01
"Control_Point _2"       -5.64690812e-01 -5.65085273e-01
1.09244112e+00

· Distances
It creates *ControlPoints_Dist.txt file - it defines the distances as seen in the
measurements tab, as:

"Control_Point_2" "Control_Point_1" 2.33824531e+01
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· The "Align model with 3D Constraints" tool

This feature is similar to the Import Constraints page when creating a new project in 3DF
Zephyr. It allows you to scale and georeference your project after creating a sparse point
cloud using cameras, constraints, or control distances.

After defining at least three constraints (1) in the GCP Panel, you can scale the model by
using them individually or together with image positions or control distances.

Changing the Constraint type filter (2) to:

- Camera option will allow viewing each image's GPS coordinates.

- Control point option will allow viewing the imported constraints from an external source.

- Control distances option will allow viewing the distances created in the Measures panel.

Pressing "CTRL+A" will allow selecting all the tab rows, and "Right-click" with the cursor
will allow you to Change Reference system and Accuracy for each camera or control point.

Constraints and Check Points column (3)

Each control point can be set as Checkpoint (to measure the residuals), Constraint (used
in the bundle adjustment), or both by using the check-boxes on the left of each point. It's
always a good idea to include some checkpoints that are not set as constraints.
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- Constraints (CS) are those points you are most confident of in terms of accuracy level,
and 3DF Zephyr relies on them to drive the scaling process.

- Checkpoints (CK) are references that the software only considers while scaling to
monitor the error value.

Example:
Let's think about an aerial survey where you have both coordinates taken using the
drone's GPS system and coordinates taken on the ground with a total station for
instance. Once you have placed your points in 3DF Zephyr, you can choose which
points must be the constraints, namely the points you are confident (of their accuracy)
the most, and which points will be taken into account as simple references to keep the
error value monitored.

Import constraints from a file button (4): 

this function allows directly set constraints from a text or .csv file via the "Import constraints
from file" button; the imported coordinates and the GCPs you have added to the project
must have the same name/label.

Coordinates should be defined using the following syntax:

"Control_Point_1" 8.18880729e-01 -5.14516149e-01 4.54143586e-01
"Control_Point _2" -5.64690812e-01 -5.65085273e-01 1.09244112e+00

.

Load GPS position from Exif button (5):

This button import camera positions by loading them from Exif information and using them
as constraints.
A common scenario is when loading information from images taken by drones or UAV
systems that record the GPS coordinates of the shots in Exif data.

It's possible to change the Target reference system (6), in a similar way seen in the GCP
tab.

Clicking on "Select reference system" will open the "Projection Coordinate System"
window:
You can select the suitable coordinate system from the 3DF Zephyr database, or import a
new one from an external source by clicking the "Import" button.
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Once the correct reference system has been set, you may also perform the Bundle
Adjustment by checking the "Perform bundle adjustment" option. This can be done by
using a slider that will assign a confidence weight in the defined constraints and an
advanced mode option. 

Click the "OK" button to start the scaling process, and an Error report will automatically
appear when it is finished. If you need to find and save the report, you can go to the menu:
Tools > Control Points > Show Alignment Info.

 Constraints Report

This button will open a summary window to display all constraints with their positions, errors
and accuracy values.

https://www.3dflow.net/wp-content/uploads/2021/12/report_error_rtk_workflow_photogrammetry.jpg
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Measures panel

Quick measurements

You can quickly pick and measure directly in 3D space using the "quick measurement
tool".

This tool allows for measuring both the horizontal and slope distance, elevation and
inclination of a segment.

The following functions are not available in 3DF Zephyr Lite and 3DF Zephyr Free.

Control Points & Distances

Control distances can be defined as the distance between two control points , the distance
between a control point and a camera, or the distance between two cameras. With 3DF
Zephyr you can easily define control distances and even scale the world with control
distances.

The "Add control distance" function

To add a new control distance, click on the “Distance” Button (1). The “control point
selection window” (2) will pop up. From this window, pick the two control points needed
from the Control Point #1 selection menu and the Control Point #2 selection menu . Once
you click “OK”, the distance will be drawn as a green line (3) and rendered onto the screen
(in this case, 6.75459).

The control distance (and the relative used control points) will also appear as a list on the
right side of the panel (4).
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Scale world with control distances function

It is possible to scale the model using control distances:to do so, simply click on the "Scale
model with control distances" button: in the window that will pop up, simply set the wanted
distances as constraints. When completed, the residue error will be shown.

Import control distances from txt file

It is possible to import control distances directly from text file: every line of the text file must
be formatted as

"Control Point #2" "Control Point"  2.18197

Measure mesh volume

It is possible to compute the mesh volume using the dedicated button. If the mesh is not
completely closed, all holes will be automatically filled and later shown with a red color - it is
possible to save that mesh as a separate workspace object.

You may also compute the volume of a dense point cloud rather than a mesh: by selecting
the desired dense point cloud as target for the computation, please note that a mesh will
be internally computed anyways.

Once you have selected the reference mesh from the menu, simply click the "Compute"
button.

Measure volume after projection

This tool allows calculation of the volume of a mesh or a point cloud by considering the
points distance and the position of a plane chosen by the user. Points under the plane are
not considered, while those above are projected on the plane's surface.
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This tool streamlines volume calculation of elements such as embankments and
excavations and it is handy for applications like 3D printing for instance.
The calculated mesh can be exported as a standard surface in the main formats provided
in 3DF Zephyr.

Volume after projection on a quarry: here the direction of the plane's normal is up

Hollow objects volume

This tool allows calculation of the volume of a cloud/mesh when the photographic survey
has been carried out from the inside of the acquired object itself, as in the case of a room
or a tank. Unlike the standard volume computation, this algorithm entails that the normals of
the objects point towards the inside. This also means that any other objects cluttering the
inner space will not be considered during this specific computation. 

Volume between two sections

You can compute the volume between two sections: simply select the two reference contour
lines from the drawing elements panel, right click, and select "compute selection volume"  

Measure mesh area

Similar to the "measure mesh" function, clicking this button will compute the area of a given
mesh. Just select the mesh and click the "Compute" button.

Measure Angles 

When at least three control points have been selected, you can compute the angle between
control points. The interface of the window that will appear will allow you to set control
points as A,B and C and then compute the angles between the vectors BA and BC. A
checkbox will allow you to change the output to radians or degrees.
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Editing panel

The editing panel allows to access the Selection/Editing tools, Filtering tools and the
drawing tools (this last function is not available in 3DF Zephyr Lite and 3DF Zephyr Free).

· Selection/editing tools

These functions allow to select elements from the workspaces so that they can be
edited/managed directly in 3DF Zephyr:

- the manual selection allows to select points (for sparse clouds and dense clouds) or
triangles (for mesh and textured mesh) through different selection modes (rectangle,
polygon, ellipse, lasso, box). By selecting the desired mode and the desired elements in
the 3D space, it will be possible to combine selected elements using the appropriate
action (add, remove and eventually by using pause to freely move in the workspace). Those
elements will be highlighted in red - once selected, it will be possible to manage them
using the appropriate commands in the "Edit" section.

- the selection by color will be applied similarly to both points and triangles: given a
certain color (that can be added manually or by picking it directly on the target object from
the 3D workspace) all points within a certain threshold will be selected.
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- the selection by plane allows to select all elements above (or below) a certain user
defined plane.

- the selection by points allow to select all those points (from sparse or dense clouds)
that are within the search parameters. The search parameters vary depending on the
selected algorithm between:

· Visible cameras;
· Reprojection error;
· X84 Statistic: this algorithm selects those points whose density doesn't meet the X84

statistic criteria. It calculates which are the nearest points or not useful to remove those
too far from the correct solution, e.g. the points describing the sky;

· Main plane fitting: this algorithm selects those points which lie well on a plane. It fits a
plane using the desired point cloud (decimated due to pc performance). It selects those
points whose distance from this fitted plane is under a certain threshold;

· Cloth simulation: it selects those points that according to this algorithm "Cloth
Simulation Filter (see http://ramm.bnu.edu.cn/projects/CSF/) appear to be terrain. 

- the selection by triangle, similarly to the previous point, allows to select all those triangle
within the search parameters depending on the selected algorithm between: longest edge,
area, connected components (this last one is very useful to quickly remove all the "floating"
noise from the reconstruction).

- the camera selection allows to select cameras directly in 3D space.

Once elements have been selected, it is possible to handle them using the editing tools:

- delete: deletes the select elements from the workspace

- invert: inverts the selection from the workspace

- cut: create a new element by removing the selected elements from the current element

- copy: create a new element by copying the elements from the current element.

- selection: allows to apply a filter only on the selected elements (smoothing, bilateral
filtering, retopology).

- confidence: allows to select (and eventually, remove) all the points below a certain
confidence threshold.

· Volume of Interest 

As of version 6.0, the Volume of Interest (VoI) is a new experimental feature designed to
aid users during the visualization and editing of huge datasets.

The user specifies a three-dimensional clipping region by visually editing it (this tool works
very similar to the bounding box editing tool).

The Volume of Interest tool is located in the Editing panel and you can click the Edit button

http://ramm.bnu.edu.cn/projects/CSF
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(1)  to enable it and open the "Edit rendering volume" window (2). 

The clipped area will be highlighted by a pink and black waving layer. Once you are done
with editing the volume, simply click the OK button (3).

The point cloud/mesh will be trimmed in terms of rendering only, and the user will be free to
leverage other tools while the VoI is running (i.e., sections, contour lines or the orthophoto
generation can be performed).

Simply click the Reset button (4) to let Zephyr render the original 3D model.
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· Filtering tools

These filters affecting both point clouds and meshes are also available in the Tools menu.
You can learn more about these function in the point cloud filters chapter and in the mesh
filters chapter.

· Drawing elements tools
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This panel includes the four CAD-dedicated tools available in 3DF Zephyr: the free
drawing, the lines and surfaces extraction, and the sections, contour lines and elevation
profile generation.

To create a new drawing element, simply click the "+" button - the new element will be
automatically added to the "Drawing Elements" section in the Project tab.
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Once an element has been created, the drop-down menu to select the current drawing
element will be enabled (in this case, it will be shown the only drawing element available,
the "Drawing Element" right under the "Create new element" button). This allows you to
select and edit previously created drawing elements.

When the drawing element has been selected, it is possible to navigate the scene to the
desired position (eventually by making use of the "Orthographic mode" checkbox).

When ready, it is possible to select the middle points that will define the shape of the drawn
element, by picking them directly on the mesh using the "Pick" button. You may also use the
"continuous mode" checkbox that won't ask for many clicks (each for every middle point)
but instead it will draw the line as long as the left click is kept pressed and the cursor is on
top of the mesh.

Press "ESC" to exit the drawing mode.

You can change the color of one (or more) drawing elements by selecting and right-clicking
the desired element(s) from the "Drawing Elements" section in the Project tab and
selecting the "Change selection color" option.

It is also possible to generate a polyline from control points: simply right click a control
point and select "Make a polyline". You will be then be able to select the points of the
polyline.

Similarly, you can also create surfaces from this very same tool, and again, you can create
them also by using control points.

3DF Zephyr also allows to automatically generate blueprints. This functionality works
better with laser scanner imported point clouds but can be used also with photogrammetry-
generated point clouds.
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Once the user has selected the appropriate mode (interiors vs exteriors) and confirmed the
automatically detected floor and ceiling planes, 3DF Zephyr will automatically compute and
save the blueprints (polylines and surfaces).

Bundle adjustment

What is the bundle adjustment?

The bundle adjustment is a non-linear minimization procedure that adjust points and
cameras by minimizing the reprojection error of points. It’s performed at the end of each
merge and a final bundle adjustment with all points and cameras is always performed at
the end of the structure from motion procedure.

3DF Zephyr (except for 3DF Zephyr Lite and 3DF Zephyr Free) allows running of additional
bundle adjustment steps manually by feeding 2D or 3D constraints.



3DF Zephyr

77 / 179

Since the bundle adjustment works on the camera internal and external parameters, keep
in mind that only the sparse point cloud will be affected by the bundle adjustment. Any
existing element such as dense clouds or meshes that are already in the workspace will not
be changed at all. It is strongly advised to run the bundle adjustment after the sparse point
cloud until the camera orientation looks right, before moving to the dense point cloud
generation.

Zephyr offers an easy to use slider to control the bundle adjustment process, in which you
can define the confidence in the constraints. It’s worth noticing that the more confidence
you put into the manual constraint, the less confidence will be made by Zephyr in its
automatically generated points.

· Running the “Workspace > Optimize Camera Parameters” menu option

This option only uses the 2D control points as constraints for the bundle adjustment. This is
weaker than using 3D constraints, however if you lack any 3D information (such as ground
control points) this is your only option.

· Running the “Align model with 3D Constraints” option

Similarly, you can run an additional bundle adjustment when scaling the model with control
points. Having additional 3D information will help Zephyr to drive the reconstruction
towards the correct solution.

The minimum number of control points set as constraints to run the bundle adjustment is 3.
However ,a higher number is advised, especially when accuracy is important.

You should only increase the bundle adjustment slider value as you increase the number of
control points defined in the workspace accordingly, otherwise the final geometry will be
closer to the defined constraints only in proximity of the aforementioned constraint points,
thus registering high deviation in all the automatically generated points.

Typical usage is when the reconstruction shows an unexpected “rounded” effect due to
drifting after the sparse point cloud has been generated, you should try running this type of
additional bundle adjustment. If the employed camera/s has/have a very high radial
distortion (i.e. fisheye lenses) make sure that “adjust radial distortion” is enabled.

When doing this, again, make sure to use a congruous amount of control points. It’s also
suggested that you use some control points as constraints, as well as some control points
only as control so that you have a way to verify that the solution has been improved (the
residual value should obviously get lower).

Setting the confidence of the constraints to 99% (or similar) is generally a bad idea.

Layers and multispectral images

3DF Zephyr supports multi layers. You can select a main layer (which will be used for
Structure from Motion) and have secondary layers that can be switched when needed.

Multi layers are often used with multispectral imagery data (see also the photometric
calibration chapter if this is your case) or with fixed shooting rig (for example to handle two
layers, one with projected patterns and one with RGB images).
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Both cases are handled the same way in Zephyr: when images have a suffix (e.g.
myfile000_layerone.jpg and myfile000_layertwo.jpg) that may seem like a layer and are
added to the project Wizard, Zephyr will ask if you wish to create a multi-layer project.

If you answer yes, Zephyr will automatically split the files into an appropriate numebr of
layers according to the suffix. If you say no, you will still be able to create layers by right-
clicking and selecting "add layer".

You can select the main layer (which will be used for the structure from motion phase) by
right clicking and selecting "set as main". Once layers have been set up, you can proceed
normally.
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The "File" menu

The "File" menu manages the opening and saving of Zephyr project files, as well as few
other functions.

In addition to the self-explanatory open/save, other functions are:

Load Model

This function allows loading of a model into Zephyr to use it as a viewer. Loading a model
will force the current workspace to be closed. The following file formats are supported:

· ply
· las
· ptx
· obj
· e57
· collada (xml, dae)
· pts
· xyz
· rcp
· fls, fws (Faro)
· zfs (Z+F)
· dp (Dot Product)
· rdbx (RIEGL)

Please note that the Faro, RIEGL, DotProduct and Z+F require the installation of additional
plugins available for free at the URL http://www.3dflow.net/native-laser-scanner-support-
plugin-3df-zephyr-download/

Load 3DK file

3DK files are Zephyr compatible projects made with the 3Dflow's SDK FlowEngine
(https://www.3dflowengine.com).

Open, Save and Load a project

Each project created with Zephyr is saved as .zep format.

Each workspace also includes the photographs used for the 3D reconstruction, therefore it
is possible to open, send and edit the path of .zep files irrespective of the location of the
image files. Nevertheless it will not be possible to start one of the four phases of 3D
reconstruction or make changes involving photograph usage.

Click on File > Open or Open Recent to open a .zep project, or click on Save or Save
As to save your work.

If you have a command-line reconstruction made with 3DF Samantha, the Structure from
Motion algorithm, you can import that by selecting File > Load from 3DF Samantha.

· Load .psz files

http://www.3dflow.net/native-laser-scanner-support-plugin-3df-zephyr-download/
http://www.3dflow.net/native-laser-scanner-support-plugin-3df-zephyr-download/
https://www.3dflowengine.com
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This function is not available in 3DF Zephyr Lite and 3DF Zephyr Free.

Within Zephyr you can be load psz project by clicking on File > Load from .psz file.

Cameras, sparse point cloud and mesh of psz project are imported In Zephyr and you can
now start  some 3D reconstruction phases such as the dense point cloud or texture
generation.

· Load pictures with known camera parameters

This function is not available in 3DF Zephyr Lite and 3DF Zephyr Free.

In Zephyr you can manually import all the parameters of a camera before starting the 
cameras orientation phase; cameras will be calibrated without being adjusted by the
Structure from Motion algorithm.

To load the parameters just click on File> Load images with known camera
parameters.

It is also possible to use .XMP files to import a specific camera configuration and skip the
sparse 3D reconstruction: this is the preferred workflow for fixed rigs.

The "Workflow" menu

The workflow menu allows users to undertake major actions within the 3D reconstruction
workflow, such as starting a new project, completing a reconstruction step or adding
photos.

The "New Project" function

By clicking "New project" the current workspace will be cleared and the new project wizard
will appear, as shown earlier in the "Starting a new project" chapter.

The "3D Model Generation" function

Starts a new dense point cloud wizard and, after that, a new mesh generation wizard.

The "Textured mesh extraction" function

Starts a new texture mesh extraction wizard. See the "Extracting a surface" chapter as
reference. More than one textured mesh can co-exist in the same workspace.

The "Orthophoto from sparse point cloud" function

Starts a new orthophoto creation wizard from sparse point cloud called orthomosaic.

The "Orthophoto from dense point cloud" function

Starts a new orthophoto creation wizard from dense point cloud called orthomosaic.

The "True orthophoto from Mesh" function



3DF Zephyr

81 / 179

Starts a new orthophoto creation wizard from Mesh called "True Orthophoto".

The "Quick Project" function

This dialog allows to quickly start a new project with a compact interface that allows to skip
many of the dialogs shown in the classic workflow wizard.

The "Add photos" function

This process allows for adding extra photos to the current project. Pictures must be taken
with the same camera rig as the one you previously used for the images you have already
processed in the current project. The "Add photos" dialog is similar to the "New project"
wizard, so you simply have to add photos by browsing or by dragging and dropping them.

 

Once the pictures have been imported, click the Next button to scroll the camera
calibration page and the camera orientation presets page. Select the category and the
presets you want to use, click Next and Run the process.

The Show advanced options section in the last wizard page allows you for manually
match the images.
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All that is required to do, is to simply select at least one camera on the left panel (by left-
clicking it) framing more or less the same area as the one displayed in the photos you want
to add. Once done, the new pictures will be listed in the "Cameras" section and the
"Sparse point cloud" will be replaced with the new one, computed using the new cameras
in the workspace. Any other workspace element (such as dense point clouds and meshes)
won't be affected automatically by this action.

The "Add photo with control points" function

Note: at least three control points have to be placed on the 3D model before running this
function.

Choose the pictures you want to add to your current dataset. Into the new window you are
requested to find the control points you have previously placed on the 3D model as well as
to provide the tool with a camera calibration file of that specific picture if it has been
captured with different camera settings.

You can reach the same function by right-clicking on a non-oriented picture inside the
Project panel and selecting the "Orient selected from control points" option.

The "Advanced" menu

The advanced menu offers some extra features:
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The "Dense Point Cloud generation" function

Starts a new dense point cloud generation wizard. See the "Extracting a dense point
cloud" chapter as reference. More than one dense point cloud can co-exist in the same
workspace.

The "Mesh extraction" function

Starts a new mesh extraction wizard. See the "Extracting a surface" chapter as reference.
More than one mesh can co-exist in the same workspace.

The "Generate and export enhanced mesh" function

This function allows to regenerate a mesh (or textured mesh) while arbitrarily densifying the
polycount and eventually by intensifying high frequencies details - please note these are
fake details as they are not generated with a photogrammetric process. This is a niche
feature developed for very specific workflows.

The "Generate and exports normal maps" function

This function opens the window that allows the generation and export of normal maps and
displacement maps. You need a high poly mesh and a low poly textured mesh in the
workspace in order to bake any of these maps.

The "Automatic register images to scans" function

This tool allows adding UAV and/or ground pictures to a set of colored laser scans. Once
done, a new sparse point cloud from photogrammetry data will be created and added to
the project. The sparse point cloud and the laser scan you have previously selected in the
tool settings will be registered together.

Please note that the laser scans must come with RGB data and origin coordinates (i.e.,
native file formats or .e57 format) and must be aligned before using this tool.

This tool saves time by avoiding creating a photogrammetry project from scratch as well as
the registration step between LiDAR and photogrammetry data.

Generate and Export planar texture maps

It's possible to generate and export planar texture maps of a textured mesh in 3DF Zephyr.

You should select a planar parts of the mesh with the Selections tools and use the Cut
tool in the editing tab.

Open the "Generate and Export Planar Texture Maps" window under the Workflow
menu.
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In the Object section choose the selected planar part of the textured mesh. A blue square
plan detector will be shown in the workspace window. It's possible to set rotation, position,
size, and the axes of the blue square plan detector.

If there are control points present on the mesh, you can use them to align the blue plan
detector on the target mesh part with Pick First Point and Pick Second Point button.

The Max texture size and Texture format can be set below the previous options.

The Pixel-level enhance filter densifies the mesh to have one triangle per pixel of the final
map and applies the enhancement filter (similar to photoconsistency).

The Map type can be used to set coordinates system (Tangent space, Object space) to
export normal maps.

In the export path space, you can set the folder for saving the exported textures.

You can decide which part of the texture can be exported (color maps, normal maps, and
displacement maps) or add the generated texture in the workspace.
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ArtEngine Seam Removal

3DF Zephyr has a native integration with ArtEngine, the material authoring toolsuite by
Unity3D.

If you own an ArtEngine license (including Betas) you can access ArtEngine features
directly within 3DF Zephyr, which can significantly speed up material scanning workflows.
For this reason, this feature is generally used after you have generated a planar texture
map.

In order to access this feature, you must right click the desired textured mesh: once the
context menu is open, simply left click on "ArtEngine Seam Removal".

Please note that this menu option won't be available unless ArtEngine is installed correctly
on your system. If you do not see this option, you may need to install a newer version or
beta depending on your license

Use the "Textured Mesh" selector to choose the desired element, and the "Texture"
selector to choose the desired texture to be rendered in the tool window. You can also
toggle the "Repeating Texture" functionality with the dedicated button on the right of the
"Texture Selector".

The functionality of the tools is pretty straightforward: you can directly edit the border
selection either with the "Seam Removal" control on the right side of the window or drag
and drop the border limits visually in the left side of the window.

You can control ArtEngine's parameters as well by using the appropriate sliders for Normal
Details and . For more information on ArtEngine's setting, please refer to their
documentation.
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Once you are ready to proceed, simply click "Compute". You can evaluate the results and
repeat the process by changing parameters and clicking "Compute" again. Once you are
happy with the result, simply click "Commit" to export the results.

Orthophoto generation

These functions are not available in 3DF Zephyr Lite and 3DF Zephyr Free.
3DF Zephyr is used in various geographic measurements, including orthophoto
generation that results from the application of drones to support topographic and land
surveying activities. The generated orthophoto use the camera information to ensure that
the dimensions represented are correct, without concerns about image distortions.

Starting the Orthophoto Creator Wizard

From the “Workflow” Menu , you can find three different orthophoto generation options :

· Orthophoto from sparse points (requires to have generated sparse points cloud).

· Orthophoto from dense points (requires to have generated dense points cloud).

· True Orthophoto from Mesh (requires to have generated the mesh).

When you select "True Orthophoto from Mesh" (1) option, the Orthophoto Wizard (2)
window will open, and a Bounding box (3) will also appear in the 3D workspace.

Step 1 - Orthophoto source

The first orthophoto wizard page will allow to define orthophoto's limits by changing the
dimensions of the bounding box in the workspace, and it will be possible to set the
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reference plane from another axis or at least 3 GCPs. The first step is to choose the
Reference object (4) among the created meshes; the Adapt Bounding box (5) button
allows to change the mesh's bounding box size automatically.

The Orthophoto wizard's default settings will create an orthophoto of the entire 3D object
with the reference plane on the Z axis. The functions below will allow to set the reference
plane from another axis or use GCPs as a reference. While changing the reference plane
or the image up direction, it will be possible to see a preview on the bounding box
represented by the red text: ��THIS WAY UP�� (6) .

Note: for practical reasons, it is best to change the Reference Plane and Image Up
directions first, as this will reset the bounding box size each time.

Reference Plane section (7)

· Reset reference plane from axis: this function allows to set the normal of the
orthophoto's reference plane from a chosen axis.

· Reset reference plane from Control points:  this function use at least three control
points to define a plane on which you want to generate the orthophoto. The plane
normal will be the new world up vector, and yellow line will be visible in the workspace
as a preview during the GCP's placement. 

Image Up section (8)

· Select image up from axis: This function uses the chosen axis to orient the image up
direction of the orthophoto. 

· Select image up from Control points: This function uses two chosen GCPs to orient
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the image up directions of the orthophoto. 

Extents section

These commands allow you to resize the Bounding box on the XYZ axes. Through the
check-boxes, it is possible to restrict one or more axes on which to resize the Bounding
Box.

Euler  Angles section

These commands allow you to rotate the Boundingbox on the XYZ axes. Through the
check-boxes, it is possible to restrict one or more axes on which to rotate the Bounding
Box.

Once the source of the Orthophoto has been set, you can proceed with the "Next" button.

Step 2 - Resolution

This page of the orthophoto wizard will present a set of options to define the orthophoto
resolution by changing the Ground sample distance and other parameters, or can also set
the resolution by specifying the image size. 

A preview will be shown in the rendering window, while the green rubber band (9) will
define boundaries within the orthophoto image.

The orthophoto wizard Resolution page is organized settings are organized into 3
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sections:

· Resolution (10): This section defines GSD and the actual size of the orthophoto. The
orthophoto Width and Height are possible to adjust according to the desired Ground
Sample Distance, or you can set the GSD directly and let 3DF Zephyr calculate the
parameter(s) for you. The Tiles Grid parameters allow setting the Tiles per height and
Tiles per width to define the numbers of vertical and horizontal tiles used to split the
orthophoto. Setting these parameters could be fundamental for huge orthophoto or
computers with a low amount of memory).

· Generation parameters (11): allows controlling every pixel's color generation mode.
This system is very similar to the texture generation system. We advise leaving the
color balance with 1 camera per pixel; however, if you wish, you may use more
cameras for a different color weight. If this happens, you may choose between an
algorithm blending method:

Multiband: will use the mean to compute low frequencies and the best
images to compute the high frequencies. This is usually a better choice than
Mean because although it is less prone to lighting changes (usually just a
little worse than mean), the resulting image will be more in focus and sharp
by preserving high frequencies.

Mean: will weight the color source depending on the view angle and the
distance. Although it's robust to lighting changes, the mean won't keep high
frequencies, so will be less in focus and sharp.

· Camera to use (12): allow the choice to ignore cameras during the generation
process by cameras directly or by tags.

Step 3 - Exporting settings
This section allow to choose the export settings and the appearance of the orthophoto.
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· Generate DTM (13): selecting this flag will automatically generate a DTM (Digital
Terrain Model) file according to the scene type. It's possible to choose three different
scenarios (Mountain area, Complex scene, and Flat terrain).

· Orthophoto appearance (14): this section enables/disables the drawing for
customizing the control points and grid on the orthophoto if desired.

When everything is ready, click "Finish".

Note: Zephyr will automatically open its DEM viewer utility when the process has finished.

Save the orthophoto outside Zephyr

At the end of the generation process the new orthophoto will be listed in the Project tab
under section Orthophoto.
By right-clicking on the orthophoto will be possible to chose the option "Export" (1), and
the Export orthophoto (2) window will appear.

· Export (3): the drop-down menu offers the option to export only the orthophoto, the
DSM, DTM or all the files.

· Image format (4): this drop-down menu allows you to save the orthophoto in these
image formats: jpg, png, and tiff. 

· Export Pdf file: exports the orthophoto in Pdf format.

· Export KML file: by enabling this checkbox, you can export an orthophoto in KML
format for Google Earth.



3DF Zephyr

91 / 179

· The Export Autocad Script File (6) flag allows the export of a .scr file that will
automatically load the orthophoto within Autocad, with the correct scale settings set in
3DF Zephyr.

· Export World file: exports the World file.

· The Tiff pyramids level (5) parameter will allow storing inside the generated tiff
orthophoto a pyramids levels layers, which can improve the display of raster data by
retrieving only data at a specific resolution required for display.

After establishing the parameters for saving the orthophoto, click "OK".A  preview (6) of
the exported files will be shown in the Save As window, Select the file name and
destination folder, and then the "OK" button to save.

Generating orthophoto via new project wizard

It's possible to generate directly an orthophoto from the Z-axis (map) in the project wizard.
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On the initial page of the project wizard, select the Orthophoto phase from the available
options in the scheme.
By clicking the "Next" button, you can navigate through the wizard's pages until you reach
the orthophoto settings page.
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RESOLUTION SECTION (1)

Switching the Mode drop-down menu between "Ground Simple Distance Driven" or
"Image Size Driven" will enable you to define either the Ground Sample Distance or
the Image Size (largest dimension).

GENERATION PARAMETERS SECTION (2)

It allows controlling every pixel's color generation mode and other tweaks. This system is
very similar to the texture generation system. We advise leaving the color balance with 1
camera per pixel; however, if you wish, you may use more cameras for a different color
weight. If this happens, you may choose between an algorithm blending method:

- Multiband: will use the mean to compute low frequencies and the best images to
compute the high frequencies. This is usually a better choice than Mean because although
it is less prone to lighting changes (usually just a little worse than mean), the resulting
image will be more in focus and sharp by preserving high frequencies.

- Mean: will weight the color source depending on the view angle and the distance.
Although it's robust to lighting changes, the mean won't keep high frequencies, so will be
less in focus and sharp.

EXPORT SECTION (3)

Export DTM: selecting this flag will automatically generate a DTM (Digital Terrain Model)
file according to the scene type. It's possible to choose three different scenarios
(Mountain area, Complex scene, and Flat terrain).

ORTHOPHOTO APPEARANCE (4)
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this section enables/disables the drawing for customizing the control points and grid on the
orthophoto if desired.

Following the reconstruction process, the orthophoto will be displayed in the Orthophoto
section of the Project tab.

Multispectral orthophoto composition

If more bands (layers) are available in the workspace, the following section will also be
shown in the Step 2 - Resolution page of the orthophoto generation wizard.

You can select the desired bands in outoput and eventually create your own composition by
clicking the "Add band" button and using the following interface:
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You may also click the "Load transform" button to access previously saved data (e.g.
NDVI) or use the save button to save your user defined formula.

Orthophoto Editor

These functions are not available in 3DF Zephyr Lite and 3DF Zephyr Free.

The Orthophoto Editor allows editing and improving specific portions of an orthophoto
created in 3DF Zephyr using chosen cameras.

After you create an orthophoto, it's possible to launch the Orthophoto Editor by either
methods:

1) Right-click on the Orthophoto that requires editing in the Orthophoto section of the
Project panel, and select the "Edit" button.
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2) Select the "tools" menu > "Workspace"  > "Edit Orthophoto". Choose the
orthophoto that needs to be edited in the Orthophoto selector dialog, click "OK", and the
Orthophoto Editor will appear.
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The Orthophoto Editor window
The editor dialog provides a set of drawing tools that can be used to select specific
regions of the orthophoto that need to be recomputed.
Let's take a look at the interface:
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On the right side of the dialog, the following are shown top to bottom:

· Regions section: A scroll-down list of the created regions, with the 3 main edit
commands:

Add a region button: 

Delete region button: 

Edit Region button: 

· Projection Type section: here, it's possible to associate a projection type with the
drawn regions,  which will be used to recalculate the color balance within the delimited
area. The two available projection methods are:

Planar: this method creates an adapted planar projection of selected reference
cameras from the right camera list into the current drawn regions. It is advisable
to use it only if you want to improve the orthophoto's visual quality of a planar
region or when the underlying mesh is not correct, and it's not primary to
maintain the accuracy of the data.

Note: when using this projection methods, at least the polygon boundaries
must lie in a planar area to avoid reprojection distortion.

Depth-based: this method makes use of the 3D information from mesh
geometry to enhance the drawn regions of the orthophoto by selecting the
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cameras on the right list. This option makes use of a similar strategy to build the
initial orthophoto but uses only the sub-set of images selected in the right list
instead, which will allow preserving the original proportions of the orthophoto. 

Example: 
If you want to remove a person or a car from a region, you can select a camera without
them as [Reference]. After that, you can deselect all the cameras where the subject is
visible; therefore will be more possibilities of removing the unwanted subject without
leaving an "image ghosting effect" in the orthophoto.

· List of the Cameras associated with the currently drawn regions. Among these
cameras, it's possible to select one [Reference] Camera that plays a central role in the
editing process and the others cameras needed for the computation by the check-
boxes. Only the selected cameras will be used during the orthophoto generation,
therefore the deselected images won't be used for color balancing. 

· Options: this check-box will enable/disable the projection preview within the drawn
region.

To finalize the editing operation click pressing the “Compute and Replace” button. If the
result is unsatisfactory, it's possible to undo the operation with CTRL+Z or the "Undo"
button, in the main 3DF Zephyr interface.

Orthophoto editing workflow

This example will explain the Orthophoto Editor workflow to improve the color balance of
selected parts and remove unwanted subjects within the orthophoto.
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Click on the "Add Regions" (1) button, in the Regions section, and create the region's
boundaries (2) on the orthophoto in the working space. To place more regions, click again
on the "Add Regions" (1) button and draw more regions; if you need to delete a region,
press the "Delete Region" button . 

Chose the Projection Type (3) between Planar and Depth based, and press the "Edit
regions" (4) button .

The editor will list all the visible cameras for the drawn regions in the Camera List (5)
section, the first picture will be the [Reference] camera used in the computation. It's
possible to choose another camera as a reference, that will be more suitable for improving
the regions, by double-click on it. 

In the example below, the [Reference] camera has been switched to one without people,
notice that the preview in the regions is changed because the Show Regions Preview
check-box is enable:
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To complete the workflow, click on the "Compute and Replace" (6) button.

The "Import" menu

The "Import" menu allows you to import different data into the workspace, for example point
clouds or meshes. Importing a model into a workspace will not cause the workspace to be
closed, so that you may combine different sources.

You may:

· Import a model (point cloud or mesh) from an external source. Any imported model at
this point will be unstructured, but it can be made structured so that the visibility



3DF Zephyr

104 / 179

information can be used. Multi-ICP alignment for laser scanned point cloud is available
for this purpose.

· Import a mesh with custom UVs in order to regenerate a texture with said UVs (the
mesh can be composed by triangles and/or quads)

· Import a whole other Zephyr workspace in order to merge it with the currently opened
one.

· Import drawing elements (DXF and XML, not available in 3DF Zephyr Lite and 3DF
Zephyr Free)

Import a model (point cloud or mesh)

These functions are not available in 3DF Zephyr Lite and 3DF Zephyr Free.

Zephyr can import all the file types supported for visualization.

To start the tool just click on Import > Import model (both point clouds and meshes) in the
menu bar. Now click on Import mesh from file button. Time taken to import depends on
the size of the mesh file.

Once the file is loaded you can click on Import in the workspace button.

Point cloud file formats available for import:

.ply .fls .xml

.las .fws

.ptx .zfs

.pts .rdb

.xyz .rdbx

.txt .dp

.e57 .x3a

.rcp .laz

Mesh file formats available for import:

.obj

.ply

.dae
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.osgb

.ive

.fbx

.xml

Import a mesh with UV map

This tool allows to import an external mesh with known UV map into the current workspace
and apply a texture on it.

Before using this tool you need to make a 3D reconstruction, usually completing at least the
mesh generation phase. In this way you can add the color information to the mesh you want
to import.

Tip: the mesh you are importing and the one generated with Zephyr must have the same
reference system. In a nutshell you have to make the same procedure as in SRT
transformation alignment tool related to point cloud import.

Merge projects

These functions are not available in 3DF Zephyr Lite and 3DF Zephyr Free.

In 3DF Zephyr you can merge two or more .zep projects related to the same scene or
subject. Simply click on Import menu and select Import and Merge another workspace
option.

To optimize the procedure it is recommended to generate just the sparse point cloud
into the projects involved before proceeding with the merge. Once this is completed it will
be possible to start the following steps of 3D reconstruction.

However, it is a perfectly valid workflow to merge two different projects with all kinds of
other elements: the wizard will ask you which other elements (any dense cloud, mesh or
textured mesh) will be imported into the current workspace.

The photographs of the projects have to share a common area so you can proceed to the
merge by means of:

· Control points: after clicking on Import > Import and merge another workspace
you will see the Import window. It is necessary to place at least three control points on
each point cloud of the projects before running this procedure. Control points must have
the same position and the same name to allow Zephyr to find matches between them
and proceed to the merge. It is recommended to keep the Compute Bundle
Adjustment option active so as to further optimize the merge process.

· Nearby cameras: click on Import > Import and merge another workspace to open
the Import window where you just select the project you want to merge and click the
Import button. If no control points are placed in the projects Zephyr will automatically
select Use the nearby cameras option.

· Same Reference systems (direct merge): is the third option which let users merge
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different projects having the same reference system (local or geographic).

In the image above you can see the pictures of current project work on the left side while
the images to be merged are shown on the right side of the window. Note that the
thumbnails of images on the right side are displayed in black and white as long as the user
selects at least one photograph from the group on the left.

First of all you need to select at least one picture in the list on the left, then you have to
select at least one picture in the list on the right. The most proper pictures to be
selected focus on a common area of the captured subject or scene.

Import drawing elements

This tool allows to import CAD elements (available file formats: .xml, .dxf) in 3DF Zephyr.

Please note that the drawing elements you are importing and the point cloud/ mesh
generated in Zephyr must have the same reference system in order to be correctly overlaid
on each other.
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The "Export" menu

The Export menu allows export of different elements from the workspace as standalone
files (for example, an obj file) or to other services (for example, direct upload to YouTube).

The "Export cameras and points" function

This function is not available in 3DF Zephyr Lite and 3DF Zephyr Free.

This function allows to export:

 - camera's internal and external parameters and projection matrices (different file formats
available);

 - sparse point cloud and camera visibility;

 - cameras to Bundler (.rd .out) and NERF/Blender formats (.json);

 - undistorted images with full or internal distortion bounding box;

The "export dense point cloud" function

This function is not available in 3DF Zephyr Lite and 3DF Zephyr Free.

This function allows for exporting dense point clouds into different file formats.

The first option in the export dialog allows the selection of the desired dense point cloud
since more than one dense point cloud can coexist in the same workspace.

The "Export format" option allows you to select the desired export format - it is possible to
export directly into .ply, .pts, .ptx, .xyz, .txt, .las, .e57, .ncn, .laz, .rcp and to the 3D
visualization web service Sketchfab. By selecting certain formats, some advanced options
may or may not be enabled.

The "Export colors" option (if selected and for the supported formats) allows for exporting
the point colors.

The "Export normals" option (if selected and for the supported formats) allows for exporting
the normals.

The "Use binary encoding" option (if selected and for the supported formats) allows for
exporting dense point clouds in binary mode (or in text mode if not selected).

The "Decimate" option (if selected) allows the automatic decimation of the dense point
cloud point number up to the desired value (as defined by the Max point cloud option).

The "Local rendering reference system" option (if selected and for the supported formats)
allows for exporting the dense point cloud by using the local rendering reference system.

The "Export mesh" function

This function allows for exporting the generated meshes to different file formats.
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The first option in the export dialog allows selection of the desired mesh, since more
meshes can coexist in the same workspace.

3DF Zephyr Lite allows for exporting 3D meshes to .ply, .stl, .obj/mtl and and to the 3D
visualization web service Sketchfab. By selecting certain formats, some advanced options
may or may not be enabled.

In addition to the above file formats, 3DF Zephyr allows you to export 3D meshes to .fbx,
pdf3D, Universal3D, Collada (.dae), .3mf and .dxf file formats. Please note that the fbx
format also allows you to export the camera positions.

The "Export normals" option (if selected and for the supported formats) allows for exporting
the normals

The "Use binary encoding" option (if selected and for the supported formats) allows for
exporting in binary mode (or in text mode if not selected)

The "Export cameras" option (only for 3DF Zephyr, if selected and for the supported
formats) allows you to save the camera positions.

The "Remesh before exporting"  option (if selected) allows the execution of the remeshing
algorithm, which will generate a new mesh with a vertex count as higher as the number
defined by the user.

The "Add comment" option (if selected and for the supported formats) allows the addition
of a text comment as file metadata.

The "Export textured mesh" function

This function allows the export of the generated textured meshes in different file formats.

The first option in the export dialog allows the selection of the desired textured mesh, since
more textured meshes can coexist in the same workspace.

3DF Zephyr Free can only export textured meshes in a limited number of formats as well as
3D visualization on Sketchfab.

3DF Zephyr Lite allows for exporting textured meshes to .ply, .obj/mtl and and to the 3D
visualization web service Sketchfab. By selecting certain formats, some advanced options
may or may not be enabled.

3DF Zephyr also allows for exporting (in addition to the formats exported by 3DF Zephyr
lite) textured meshes to .fbx, pdf 3D, Universal3D, Collada and USD file formats. Please
note that the fbx format also allows export of the camera positions.

The "Export normals" option (if selected and for the supported formats) allows the export of
the normals.

The "Use binary encoding" option (if selected and for the supported formats) allows for
exporting in binary mode (or in text mode if not selected).

The "Export cameras" option (not available in 3DF Zephyr Lite and 3DF Zephyr Free), if
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selected and for the supported formats, allows for saving the camera positions.

The "Add comment" option (if selected and for the supported formats) allows addition of a
text comment as file metadata.

This dialog also allows you to choose, when available, the texture export format (PNG,
JPG, EXR and TIFF32) as well as select the maximum size of the texture. If you wish to
rescale the texture, please note that it's a simple rescaling operation, which does not add
detail. You may rescale to a fixed power of two size or automatically compute the nearest
power of two value.

The "Export LOD Mesh" function

This function is not available in 3DF Zephyr Lite and 3DF Zephyr Free.

The mesh will be re-generated and split into a certain number of tiles in order to preserve
level of detail over huge meshes. Export formats available: Kmz, Zip, Osgb, Ive, Obj, Gltf,
Glb+dds Gzip.

The "Export control points" function

This function is not available in 3DF Zephyr Lite and 3DF Zephyr Free.

This button opens the same dialog that the "Export data" button shows from the "Control
point" panel.

The "Export workspace" function

This function is not available in 3DF Zephyr Lite and 3DF Zephyr Free.

This function allows the  export of the workspace to .ply/text files.

The "Export processing report" function

This function is not available in 3DF Zephyr Lite and 3DF Zephyr Free.

This function will create a pdf report about the current workspace. The report will contain
information about the workspace, from the sparse point cloud to the textured mesh, with a
technical summary and statistics.

The "Export current view as PDF"

This function allows for generating a screenshot of the workspace current view, as a PDF
file.

The "Take screenshot" function

Like the "Export current view as PDF" function, this function allows for creating a
screenshot of the current view, as an image file. Some additional options are available,
such as the possibility to have a transparent background.



3DF Zephyr

110 / 179

The "Edit" menu

From the "Edit" menu it is possible to quickly access the classic "Undo" (CTRL+Z) and
"Redo" (CTRL+Y) actions.

Not all actions in Zephyr support undo/redo.

The command history can be seen from the "History" panel.

The "Scene" menu

This menu allows the user to manage how the subject is rendered and how the bounding
box is defined in the scene.

Most of these functions have a quick access button on the main toolbar.

Camera management via the "Camera" menu

Zephyr allows navigation of the scene in three different ways:

· Orbit: in order to navigate the scene in "orbit" mode the mouse cursor has to be on
scene: keep the left mouse button pressed and move the mouse to orbit around the
subject. To zoom in or out, keep pressed the left shift button and move the mouse
forward/backwards. The pivot is centered as the center of the bounding box.

· Orbit with pivot: similar to orbit; however, the pivot will be moved where the mouse
cursor is at the time of the left-click button press.

· Free look: "first person shooter" view where the movement is applied via the WASD
buttons (W forward, S backwards, A left, D right) and Q/E (up,down).

The "Orthographic projection" camera mode can be toggled via the dedicated check-box.

Finally, there are buttons that allow the user to move quickly into a predefined position with
respect to the subject (move left, move up, etc.) and a reset camera button.

Rendering management

The rendering settings can be changed by modifying the following settings:

Turn light on/off: toggles the lighting applied to the scene

Show only sparse point cloud: changes the current active workspace object to the sparse
point cloud.

Show only dense point cloud: changes the current active workspace object to the dense
point cloud.

Show only mesh: changes the current active workspace object to the mesh.

Show only textured mesh: changes the current active workspace object to the textured
mesh.

Enable/Disable wireframe: toggles the wireframe visualization
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Enable/Disable colors : if the lighting is enabled, this can be used to disable the mesh
color for an easier mesh inspection. Obviously, if the lighting is turned off this option won't
be enabled as well.

Enable/Disable culling: toggles triangle culling

Enable/Disable volume: shows the computed mesh volume

Edit bounding box

You can enable the bounding box widget from this submenu.

The "Tools" Menu

Tools that directly impact the workspace are grouped under the "Tools" menu.

Tools - Workspace

The Workspace menu allows for running tools dedicated to 3D objects management and
pictures used in the 3D reconstruction:

· Scale/Rotate/Translate Objects: this tool opens a window that allows the user to
scale/rotate/translate the 3D models (clouds and meshes) either by inserting your
desired values or by using the 3D gizmo performing a manual transformation.

Besides, from this window, you can also edit the pivot of your gizmo, and find other
alignment tools such as:

o Define the up axis by drawing a line: allows drawing of a single segment
directly on the 3D model to be aligned with the desired axis (the drawing must
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be done on an element of the 3D model that is actually on the up vector in the
real world, such as a wall in a building).

o Define the up axis by drawing a triangle base: allows drawing of a triangle
(a plane) from which the Z axis will be computed (the plane must be done on an
element of the 3D model that is actually on the horizontal axis in the real world,
such as the ground). After picking the second point in the plane, two arrows will
be rendered on the screen, one that will show the selected axis (blue arrow) and
the normal direction of the plane (light blue arrow). In order to correctly align the
axis, the two arrows must match.

Please note: the Reset tool in the "Controls" section allows for resetting the gizmo to the
initial state, whereas the Reset tool in the "Gizmo tools" section resets the gizmo
independently from the 3D object.

· Transform Rendering Reference System: allows to scale/translate the 3D viewport.

· Define the up vector with control points: this tool opens a windows that allows to
select at least 3 GCPs previously placed to define a plane on your point clouds or
meshes: its resulting normal will be the new up vector.

· Define the up vector with a point cloud: allows to define the vector from points
(either of sparse point cloud and dense point clouds) and to set the desired inlier
threshold.

· Change Workspace Images: this tool is very useful when working with thermal or NIR
(Near Infrared) images: after the 3D reconstruction has been completed using classic
RGB images from a normal camera, you can swap the corresponding NIR/thermal
image and everything will behave exactly as the sparse point cloud was made with
those images. Although this is still a valid workflow, you should now use the multilayer
workflow for this case.

· Change Masks: allows changing of the masks used for the current dataset.

· Generate Masks from Model: allows to use the 3D model as a reference to calculate
the reprojection and generate the related masks. It's useful when dealing with post-
processing in other 3D modeling software.

· Minimal overlap camera selector: allows to define the minimal set of cameras that
view a point cloud/mesh. Useful to reduce the camera overlap and not consider
redundant cameras.

· Delete All Masks: this option becomes enabled when there are masks uploaded into
the workspace, allowing the user to delete them from the project if needed.

· Edit Orthophoto: this option becomes enabled when there are orthophotos which
have been previously generated or imported into the workspace. This tool opens the
"Orthophoto Editor" window which allows to make some visual changes to the
orthophotos.

· Camera Stats: shows information about the mean reprojection error and the number of
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points viewed by each camera in the sparse point cloud.

· Matches Viewer: opens the match viewer interface. Simply select an image on the left
panel by left-clicking it and similarly an image on the right panel. After clicking "next",
keypoints and matches will be shown with a line between the two images. Simply click
"back" and repeat the process to see matches from different images.

· Camera Links: they show the strength of the matches between the cameras during the
orientation phase. A series of lines which link the cameras will be shown in the
workspace according to a matching threshold defined by the user, while their degree of
intensity is indicated through a color map.
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· Point Inspection: this tool enables the user to pick a desired point upon your 3D
model. The cameras that see that specific point will be shown in the viewport and listed
in the dedicated window, along with its XYZ position in the 3D space.

· Camera GPS Coordinates: shows a preview of the GPS coordinates via
OpenStreetMap.

· Enable/Disable Confidence: allows the user to see/hide information about the dense
point cloud confidence.

· Optimize camera parameters: this tool allows running a further bundle adjustment, in
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order to improve the accuracy of the Structure from Motion algorithm. It is advisable to
run this tool before running the Multi View Stereo phase (dense point cloud extraction).

Tip: a typical case in which the bundle adjustment step is required is when the first camera
orientation step has completed with a mean reprojection error value above 1: after placing
at least three control points from the images it is possible to run the "optimize camera
parameters" step, giving much more weight to the defined constraints.

· Optimize camera parameters using terrain assumption (experimental)

This tool allows the user to run the bundle adjustment, however by assuming a terrain. This
is very useful when the structure from motion suffers from error drifting and causes the
reconstruction to look "bent". By using this tool, Zephyr will guide the reconstruction using a
planar assumption.

· Manage camera layers: manage multi-layers for multi-layers datasets.

Tools - Selection

The "Selection" menu allows the user to apply certain functions to the workspace elements
- most of these commands have a direct quick button on the main toolbar. These tools have
the same effect as those in the editing panel.

Select All: selects all the currently active items in the workspace - triangles for meshes,
points for clouds. The selected part will be highlighted by a red color.

Select None: Undo the previous selection of all the active items in the workspace.

Invert Selection: invert the previously done selection. The selected part will be highlighted
by a red color.

Delete Selected Items: deletes those elements currently selected (highlighted in red) from
the currently active object.

Manual Selection: allows to select points (for sparse clouds and dense clouds) or
triangles (for mesh and textured mesh) through different selection modes (rectangle,
polygon, ellipse, lasso, box). By choosing the desired mode and the desired elements in
the 3D space, it will be possible to combine them using the appropriate action (add,
remove and by using the pause button to freely move in the workspace). All the selected
elements will be highlighted in red.

Select by Color: selects (on dense point clouds) all the points of a given color (within a
given threshold).

Select by Plane: selects a part of the currently active subject - the selection is done by
placing a plane that will "cut" the subject - all points above that plane will be selected. The
selected part will be highlighted with a red color.

Select by Points: allows selection of a part of the currently active object in the workspace
- the selection is made by including all the points contained within a dragged rectangle in
the workspace (keeping the left-click button pressed) - when the click is released, the
selection will be done. The selected part will be highlighted with a red color.
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Select by Triangle: allows selection of a part of the currently active object in the
workspace - the selection is made by including all the points contained withing a polygon
defined by clicking and connecting the polygon points in the workspace - when the polygon
is closed, the selected part will be highlighted by a red color.

Select Cameras: allows selections of the workspace cameras through different selection
modes (rectangle, polygon, ellipse, lasso). Once selected, the cameras will be highlighted
in orange both in the viewport and in the camera navigator.

New Object Via Copy: creates a new object in the workspace, by making a copy of the
current selection.

New Object Via Cut: creates a new object in the workspace, by cutting the selected
object. The inverse of the selection will become the origin object.

Tools - Point Cloud Filters

From this menu it's possible to apply the selected mesh filter to a dense point cloud in the
workspace.

Decimation: select the desired point cloud with the dropdown menu and the number of
desired points. The point cloud will be regenerated decimating the point count to the
maximum specified value.

More specifically, it is possible to decimate the desired point cloud using these different
methods:

- Maximum points count;
- Maximum points count with octree (the octree is a data structure which guarantees a
more homogeneous distribution of the decimated points);
- Average point distance;
- Octree size.

Densification: select the desired point cloud with the dropdown menu and the number of
desired points. The point cloud will be regenerated densifying the point count to the
maximum specified value. Only structured point clouds can be densified.

Project on Regular Grid: with this filter it's possible to use a regular grid as a projection
for the dense point cloud, so that points are at a regular distance. You may define the grid
spacing as well as the grid research value for the grid generation. This tool is especially
useful for aerial datasets in topography.

Ground Extraction Filter: allows the automatic extraction of the terrain from a dense
point cloud to create a 3D Digital Terrain Model (DTM) and eliminate everything above,
such as trees and houses. Users can select the dense point cloud and set the following
parameters:

· Scene: suggests filtering the type of scenario that has been reconstructed in 3D.

· Resolution: refers to the grid size of cloth that is used to cover the terrain. The bigger
the resolution, the coarser the DTM.

· Height threshold: refers to a threshold to classify the point clouds into the ground and



3DF Zephyr

117 / 179

non-ground parts based on the distances between points and the simulated terrain.

Update Colors: This filter can be used either to recompute colors from images (useful
when you are changing the workspace images) or by elevation (useful to colorize a
laserscan cloud for example). If you choose the latter, a list of available color maps will be
shown for selection.

Tools - Mesh Filters

From this menu it's possible to apply the selected mesh filter to a mesh in the workspace.

Decimation: allows selecting the referred mesh from the drop-down menu and setting the
number of corresponding vertices. The mesh will be regenerated by decimating the
number of vertices with the specified maximum value. You can ask the software to:

·   Preserve the boundaries: with this option, the vertices borders are never decimated.
Therefore, it will allow having an edge equal to the starting mesh; the disadvantage is
that the border remains much denser at the inner part's expense, resulting in fewer
points and less detail.

·  Filter only selected triangles: with this option, you can decimate just the mesh areas
previously selected with the selection tools.

Densification: select the reference mesh with the drop-down menu and the desired
number of vertices. The mesh will be regenerated by densifying the number of vertices with
the specified maximum value.
You can either apply the filter to the mesh you have selected or clone it and filter the mesh
copy.
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Retopology: This filter allows you to optimize the mesh topology. Triangles will be
simplified and Zephyr will try to generate larger triangles where possible. The greater the
optimization factor, the larger the size of the generated triangles. Please, note the filter may
cause a loss of mesh detail, especially where there are geometries with well-defined
edges.

Laplacian smoother: reduces the mesh noise and does not keep sharp edges. The more
iterations are inserted, the more smooth the mesh will be. This filter is suitable for non-
edged subjects (e.g., human body datasets).

Bilateral smoother: the filter allows to smooth selected mesh with the appropriate drop-
down menu, and it reduces noise by improving and emphasizing edges where it is
possible. This filter is suitable for architecture and construction scenarios.

Photoconsistency Based Optimization: this is a kind of filter that, based on photos,
optimizes the surface of the model to make it as much consistent as possible with the
starting images, through a minimization process, where at each iteration, the surface is
modified in such a way as to reduce the error of reprojection of one image on the other.
This allows obtaining a much more detailed rendering of the surface, thus increasing its
accuracy.
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Here below, a detailed analysis of how to change these settings; in brackets ( ), you will
find the default values:

· Image resolution (50): controls the image’s scale resolution used internally by the
photoconsistency algorithm. If you already have suitable initial geometry, it is
reasonable to run the photoconsistency with a high resolution (50% – 75%). If the input
is of poor quality, it is advised to leave a low resolution (25%).

· Hierarchical subdivision (1): if this value is greater than zero, the photoconsistency
algorithm will be sequentially applied more times, automatically adjusting the image
resolution and the iteration number. This means that the same results can be obtained
by running the same algorithm multiple times with different and appropriate settings.

· Reprojection area (20): controls the size that every triangle will try to obtain at the end
of the photoconsistency process. Given a triangle, its final reprojection area (in pixels)
to the nearest camera will tend to get near to the specified value. Lowering this value
will make a denser mesh: the final mesh will then have a variable level of detail, with a
higher vertex point cloud corresponding to those areas viewed by nearer cameras. In
most cases, the default value will work well; in case you are dealing with a mesh that is
already very good (for example, one that has already finished a photoconsistency step).
This parameter can be lowered to get more detail; instead, it can be raised in very
noisy meshes and low-quality images.

· Edge filter (0): this parameter is used to emphasize edges; the more the mesh is
angular (buildings, objects, etc.), the more you can increase this value. Usually, it can be
kept at a value of 0.5.

· Enhance filter (0): it is a post-processing method that can generate “fake details” by
increasing the number of mesh triangles. Depending on the result you want to obtain
and the photo’s quality, you need to carefully adjust the slider to avoid creating
additional noise instead of additional details.

· Update colors: calculate vertex colors according to cameras. It recalculates the colors
each time after making the photoconsistency. The flag can disable for the test, and the
colors can be recalculated later.

Ground Extraction Filter: allows the automatic extraction of the terrain from a mesh to
create a 3D Digital Terrain Model (DTM) and eliminate everything above, such as trees
and houses. Users can select the mesh and set the following parameters:

· Scene: suggests filtering the type of scenario that has been reconstructed in 3D.

· Resolution: refers to the grid size of cloth that is used to cover the terrain. The bigger
the resolution, the coarser the DTM.

· Height threshold: refers to a threshold to classify the point clouds into the ground and
non-ground parts based on the distances between points and the simulated terrain.

The “preview” button will highlight the terrain elements as green and non-terrain elements
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as red. Optionally, you can use a selection to force non-terrain regions.

Update colors: this filter allows re-computing mesh colors:

· From images: (e.g., to change the workspace pictures if you are dealing with
multispectral imagery).

· By elevation: it updates the colors according to the points’ elevation. A list of color
maps will allow you to pick among several color palettes.

· By normals: using normal maps from the dataset images.

· Uniform: choosing one specific color from a color palette.

· By curvature: different sets of colors can be applied according to the local geometry,
which means the color varies depending on whether the area is flat, angular, or curved.

Fill Holes Selective or WaterTight: it allows to automatically fill and close holes in the
meshes. There are two modes are available:

·  WaterTight mode: allows automatically filling all the holes at once.

· Selective mode: allows filling the holes manually in the selection window. You can
select a specific hole by:

     - Number: choosing it directly in the 3D workspace with the pick hole button, or the
corresponding number (the hole will be highlighted with an outline in the workspace).  
     - Size: defining the size threshold using the dedicated slider.

The color of the triangles that will close the hole will most likely be wrong when the missing
visibility of the point from the camera will behave in a degenerated way (and it is
impossible to identify the color of something that is not seen by any picture).
The Selective mode allows you to close single holes faster, but it may not work for
complex cases, which we recommend using the WaterTight mode.

Cut with bounding box: by changing the bounding box’s size created by the mesh, it can
be adjusted to cut unnecessary parts and exclude them outside the bounding box.

Cut with plane: this function allows you to cut the mesh sharply with a plane, regenerating
the triangles on the edge where cut.

Tools - Control points and Distances

These functions are not available in 3DF Zephyr Lite and 3DF Zephyr Free.

This menu allows access to certain control points tools.

Scale Model: it opens the same window shown in the "GCP" tab by clicking on "Align
model with 3D Constraints".
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Show constraints report: it opens the same window shown in the "GCP" tab by clicking
on "Constraints report".

Show Alignment Info: shows information about the latest "Align model with 3D
Constraints" operation, with the final mean error and the error of every constraint.

Change Reference System: allows change of the reference system of the project. You
must have already defined the reference system with control points before you can change
the reference system.

Import & Export 2D / 3D Coordinates: these functions are the same shown in the "GCP"
tab, under the "Import / Export" section.

Print Markers and markers use

This chapter explains how to use coded targets in 3DF Zephyr in order to further improve
the cameras orientation phase.

3DF Zephyr’s coded targets are square-shaped (see image below).

In order to print coded targets just click the Tools button in Zephyr’s menu bar and then on
Control points > Print Markers. You can print as many targets as needed.

3DF Zephyr supports 16 bit coded targets: their size strictly depends on the kind of 3D
reconstruction and the related photographic survey as well.

Recommended settings are as follows:

Close Range and Human Body 4 targets per sheet (A4 size)
Urban 2 targets per sheet (A4 size)
Aerial 1 target per sheet (A4 or A3 size)

You can define the amount of targets per sheet by editing the printing menu settings on
Windows (the term “page” implies a target inside that menu).
It is recommended NOT to use coded targets randomly; instead it is highly recommended
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to use them in their own numerical sequence (1, 2, 3, 4, etc. and not 4, 13, 22, etc.).

With 3DF Zephyr, you can also automatically detect standard targets, either square, round,
or custom ones.
When a photographic survey is completed and after the cameras orientation phase is
done you can start the automatic detection of coded targets by clicking on Tools >
Control Points > Detect Markers.
In the new window you have to specify:

- The markers family: allows to choose which markers have been used in field.
- The subsampling;
- The gaussian blur intensity;
- The number of coded targets within the scene.

After clicking the confirmation button, 3DF Zephyr will start the automatic target recognition
and will set the control points based on the detected targets.

NB: Please note that the automatic target recognition has to be started AFTER having
completed the camera orientation phase in Zephyr.

Tools - Distances and Measurements

These functions are not available in 3DF Zephyr Lite and 3DF Zephyr Free.

This menu allows access to the most used Distance and Measurement tools already
present in the Measures panel.

Area: allows to compute the area of a given mesh.

Volume: allows to compute the mesh volume. If the mesh is not completely closed, all
holes will be automatically filled and later shown with a red color.

Volume with Projection: allows calculation of the volume of a mesh or a point cloud by
considering the points distance and the position of a plane chosen by the user. Points
under the plane are not considered, while those above are projected on the plane's
surface.

Hollow Volume: allows calculation of the volume of a cloud/mesh when the photographic
survey has been carried out from the inside of the acquired object itself, as in the case of a
room or a tank.

Angles: when at least three control points have been selected, you can compute the angle
between control points. The interface of the window that will appear will allow you to set
control points as A,B and C and then compute the angles between the vectors BA and BC.
A checkbox will allow you to change the output to radians or degrees.

Quick Measurements: this function is also present on the toolbar with the icon  and it
allows to quickly pick and measure directly in the 3D space. This tool allows also for
measuring the horizontal, elevation and inclination of a segment.
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Tools - Registration

These functions are not available in 3DF Zephyr Lite and 3DF Zephyr Free.

The registration menu allows the user to handle point clouds registration. From this menu
you can access the ICP function (Iterative Closest Point) which is an algorithm employed to
minimize the difference between two point clouds and see a point cloud difference report.

Point cloud registration (ICP)

Use this function when you need to align a laser scanned point cloud with a
photogrammetry point cloud: this function considers translation, rotation and scale. Using
this function you can then align a laser scanned point cloud which can later, for example, be
structured and colored with the photogrammetry obtained point cloud.

Multi view point cloud bundle adjustment (Multi ICP)

Use this function when dealing with many point clouds that are already in the correct scale
system, for example multiple scans from a laser scanner device. This function does not
apply any scale factor.

Please remember that:

· The objects must be close to each other
· You can use this tool to register multiple unstructured objects and structured ones
· The adjustment and the minimization will be performed in a global way
· If you need to register point sets with different scales, it is advisable to use the two view

ICP dialog and enable scaling.

When objects are not close enough (as in most cases) simply use the gizmo  to bring
the point clouds close together. Please refer to 3dflow.net online tutorials for a visual
explanation of this process.

The fist wizard page will ask which objects will interact:
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The next page will allow the selection of the reference object. Then, you will be able to
define the object pairings:
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In most cases, pairings should not be changed as they should be automatically selected so
no other interaction from the user is requested. Finally, you can define the stop conditions
before you are shown a recap page where you can start the actual computation.
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Max distance point removal: when two or more point clouds are registered using the ICP
algorithm, the corresponding points are calculated at each iteration by the algorithm itself.
Since it often occurs that point clouds depict different areas of a certain object/scene, a
procedure to remove too far corresponding points needs to be applied. Indeed, the
registration process would lead to a wrong result without that removal step.

The removal threshold can be calculated:

 - automatically (X84 statistical analysis between point distances);
 - manually (user is requested to set a metric value);

Point cloud comparison

This function allows computation of a comparison between two selected point clouds. A
chart is then plotted that graphically explains the residuals as a histogram. You can notice
the errors recap on the bottom of the window (mean error and variance). Users should run
this tool after the two clouds have been aligned to each other. Cloud comparison
parameter settings are as follows:

· Distance type: indicates the distance to be calculated and users can choose either
"point to point" or "plane to point" distance;

· Farthest points removal distance: represents the highest value during the histogram
computation;
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· Number of Bins: defines the histogram amount of columns;

As for the residuals computation process:

 - The first step computes the closest point of the model for every point of the target;

 - If a distance between a couple of points is greater than the maximum distance value, that
distance won't be considered into the computation;

It is also possible to select parts of the histogram to highlight only a certain number of
points of the "model" point cloud directly in the 3D room.

In the 'Point to point' comparison the histogram is built by considering the closest point A
for each point B. All the spatial distances are from A to B are used to build the histogram
and color the point cloud accordingly. The 'Plane' metric is a bit different. In this case a
plane is fitted considering B and its neighbors. The distance is then calculated from A to
the fitted plane. The latter is useful with buildings and walls.

Match objects center

This tool can be used after creating a photogrammetric dense point cloud and importing
then a laser scanner cloud. It often occurs that a scan has been acquired in a different
reference system compared to the one of the photogrammetric dense point cloud. This is
why sometimes users are not able to see  the imported scan into the Zephyr's 3D room.
The "match objects center" tool allows to move the imported scan closely to a structured
object, namely the photogrammetric dense point cloud.

Point cloud registration using control points
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When dealing with a very noise photogrammetry point cloud or excessively planar surfaces
(building facades), you may want to use control points prior the ICP alignment.
In this case, the alignment via control point takes just a few clicks and can vastly improve
the results.

The first step is to put at least three control points on the first point cloud you are dealing
with. Depending on what you are doing, you might want to move the photogrammetry point
cloud rather than the laser point cloud. Regardless of this, you will have to then apply the
same control points over the other point cloud.

In this example, we start by importing the unstructured laser scan point cloud inside Zephyr.
After this is done, it is then possible to rescale the imported point cloud and position it near
the photogrammetry point cloud (although this is not essential).

The next step is now to select three control points. You may pick the control points with any
method, although using images is advised. Try to select control points that later on you will
able to easily recognize and select on the other point cloud: usually, edges work very well.
Keep in mind that you should also select points that are displaced on all three axis.

When this is done, you can pick the same three control points on the unstructured objects.
Make sure to use easy recognizable names as you will have to manually select the control
points pairing. Note how control points are grouped by object (photogrammetric point
cloud/laser scan) in the “GCP” panel.
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When all the control points have been placed, simply select Tools > Registration >
Control points registration from the menu.

Select which object will move and which one will stay in its position.
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Use the “Add Constraint” button to select the pairings, according to your naming
convention that you used earlier. At least three constraints are required.
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When ready, click “Next” and the summary will appear. Click “Apply” to continue.

At this point, the point clouds have been aligned correctly. An additional ICP step is
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advised at this point to minimize errors.

Structuring laser scans:

Once the registration is completed, simply select the desired dense point cloud from the
“Project” Tab, right click it and then click “Make structured”. Select the options accordingly
to your needs, as shown below:

After the structuring, now you are ready for the mesh generation. Please remember to
select the correct amount of seed points from this dialog according to the level of detail
you want to obtain in your final mesh.

Tools - Sections and Contour Lines

These functions are not available in 3DF Zephyr Lite and 3DF Zephyr Free.

By clicking on Tools > Sections and Contour Lines you can select the drawing element
you want to create choosing from:

· Sections: this tool generates only one plane that you can move, rotate and resize; the
position of the plane can also be modified using the control points, if they have been
previously placed on the 3D model;

With this tool, a window will pop up after the plane has been placed (see image below).
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In this window you can draw sections and contour lines previously identified by the planes
both automatically or manually. In the upper bar of the window there are editing and
drawing icons as follows (from left to right):

 - Create: manual method that allows you to draw a polyline;

 - Remove: removes the vertex of a polyline;

 - Move: moves the vertex of a polyline;

 - Split: adds vertex to a polyline;

 - Clear: deletes all polylines;

 - Close Polylines: closes a polyline;

 - Smooth Polylines: allows you to smooth all the polylines drawn;

 - Autocompute Current: generates a polyline only on the section shown in the window;

 - Autocompute All: generates a polyline for each section previously created using the

planes;

 - Export: allows export of drawings as .dxf and .shp format;

 - Import to Workspace: allows to import drawing elements in Zephyr workspace;

Previous and Next icon allow scrolling among the sections created.

· Track Sections: this tool generates several planes (user can fix the amount of those)
on each position of the control points so it is worthwhile when it is necessary to draw
sections on an irregular path (for example, a river bed);

· Contour Lines: allows generation of one or more contour lines on the 3D model and
user can choose the reference axis for contour lines direction;
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· Elevation profile from Drawing Element: allows generating elevation profiles if at
least one drawing element (polyline) has been created. Please check the DEM Viewer
section to understand how the elevation profile tool works.

Tools - Lines Extraction

These functions are not available in 3DF Zephyr Lite and 3DF Zephyr Free.

Via the "Lines Extraction" menu, it is possible to add drawing element to the project via a
manual/assisted method or via a completely automated function.

Manual Lines Extraction

Zephyr offers the manual lines extraction feature in two different workflows: one that
requires to define a certain set of points on at least two pictures (given a sparse point
cloud) and one that requires to define a certain set of points in just one picture (given a
dense point cloud or a mesh).

· Manual extraction given two images and one sparse point cloud (multi camera
polyline)

In order to extract lines manually, a certain set of points must be defined on at least two
pictures. This is done manually on the first selected picture, while an assisted automated
point detection is offered when selecting other images. 

The point definition interface is similar to the one used to define control points, with the
scroll-wheel used to zoom in and out and to pan the image via mousewheel click. On the
right panel, the polyline name can be edited as well as the defined points. The top toolbar
allows to switch from the "add mode" (which adds a new point) to the "edit mode" (which
allows to edit a previously picked point).
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After selecting at least two points on the first image, the same points (in the same
sequence) must be selected on another image.

Points can be selected manually again, and you will see that a red circle will be enabled
along with the line where Zephyr expect to view the points of the polyline.

You can also perform automatic attempt by clicking "Automatic matching". When all the
points are defined correctly, you may press OK to finish and automatically import the new
polyline in the workspace, which will be added to the drawing elements section.
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· Manual extraction given a picture and a dense point cloud/mesh (single camera
polyline)

If at least a structured dense point cloud is available in the workspace, it is possible to
extract polylines with a very similar workspace, however using only image. Thanks to the
dense point cloud, the points projection will automatically extract the desired polyline.

The interface is very similar to the one mentioned above: simply select the desired polyline
points in one image and the reference point cloud to generate the target polyline.
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Automatic Lines Extraction

You may let Zephyr do all the work and automatically extract lines. This process requires to
set a line distance (which makes sense when you have scaled the model to a known
measure) and allows also for a preview per-image. Please note that although all the
automatically extracted lines are grouped togheter in the "Drawing Elements" section,
when exported in DXF, every polyline will have its own definition.
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Make Polyline from Control Points

You can generate polylines by placing at least 2 control points in the 3D space. In the
dedicated window, you will be asked to choose which control points to use for the polyline
creation.
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Drawing Elements & Layers

These functions are not available in 3DF Zephyr Lite and 3DF Zephyr Free.

The Free Drawing tool in the "Drawing" section of the Editing tab allows you to draw
polylines, splines, surfaces, points, and text directly on the 3D model.

Please note that drawing elements can be exported into DXF, SHP, DNG and XML files.  
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You can choose the drawing element type (polyline, surface, spline, point, text) from the
popup dialog, by pressing the  button.
To create a new separate drawing element, the Create new element checkbox must be
selected.
It's possible to rename the drawing element and change its color before pressing OK.

Once you draw a polyline or a spline, you can close the drawing element by clicking on
another vertex. A popup window will be asking you if you want to close the drawing
element:
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By clicking the Edit button , it's possible to add, relocate, and remove the selected
point of a certain polyline, spline or surface. You can also subdivide the polyline by clicking
on the Subdivide button .
Once the Edit button is pressed, it's possible to move the drawing element vertices by

pressing the Move button , or delete them with the Remove button .

You can also use the Snap function to link the polyline you're currently drawing to another
already created: you can do that by using the main vertices ("snaps") of the drawing
elements, such as the near/mid/end vertex.

The following modes can support you while placing the polyline/spline/surface points in the
3D workspace:
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· Preview next point allows to have a preview of a point that has not been placed yet.
This mode is handy for splines creation because you can check the curvature trend
while placing the points.

· Continuous mode allows for automatically placing multiple points while moving the
cursor.

· Orthographic mode allows for switching to the orthographic view during the drawing
elements creation.

· Show elevations allows for displaying the elevations of the drawing elements' points.

The drawing elements can be grouped into layers regardless of their generation method. In
order to do so, you simply have to select the desired drawing element (you may also use
multiple selection to move more drawings to the same layer), right click and select the
appropriate "move selection to" entry.
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Note: the following tools are available after the drawing elements creation:

Extract control points - allows creating control points from already placed drawing
elements vertices.

Selection - simply right click on a closed polyline/spline and pick the "use for selection"
option to select points or polygons enclosed by the relative polyline/spline.
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Cutting - right click on a closed polyline/spline and pick the "use for cutting" option to cut
the area enclosed by the relative polyline/spline.
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Merge - Allows to combine separate drawing elements of the same type.
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Properties show information about the selected drawing element. Right click on a
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polyline/spline to choose among Delete, Duplicate as Drawing Elements or Join option.

Please note that you need to select the drawing elements listed in the properties and right
click the Join option in order to join them together. Once you are done, the properties will
list only one polyline/spline.

Guided BreakLines

To create breaklines, simply click Tools > Lines Extraction > Guided BreakLines
Extraction, or select the "Guided BreakLine" option under the Drawing section from the
Editing tab.
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Click the  button in the popup dialog to rename the breakline and/or change its color.
Click OK to add the new drawing element to the current workspace.

Breakline creation Settings are as follows:

- Max Segments number: defines the maximum number of the breakline segments to
detect.
- Max Angle degree: sets the maximum angle between two segments.
- Explore more during detection: this flag enable a more explorative detection, which
helps recognize more extended profiles on the mesh structure. This option increases the
amount of calculation conditions of the algorithm in order to find longer and more
articulated profiles. You can enable this option if the standard guidance is not good
enough. Be aware that drifts are more likely to occur.

Once you draw the first vertex, you will notice the breakline will point to the vertex closest to
the mouse cursor while hovering the mesh (guided drawing mode). A preview of the
breakline (blue line) will be displayed in the meantime. You have to left-click again to add
the breakline.

Drawing can be paused and resumed by clicking the "Pause" and "Continue" buttons,
respectively.

You can switch between guided and manual drawing mode anytime by clicking the Free
drawing / Guided drawing button.
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Note: the segments size of the breakline will be similar to the first drawn segment. In this
respect, the algorithm behavior is highly influenced by the length of the first segment and it
will try to replicate the same length for the successive segments. Therefore, if the searched
profile is extended, it's usually recommended to draw a relatively big first segment in order
to save time. However, please be aware as the segment size determines the accuracy of
the final line.

Tools - Surfaces Extraction

These functions are not available in 3DF Zephyr Lite and 3DF Zephyr Free.

You can generate surfaces manually using control points or by using our blueprint
generation method.

· Blueprint generation

This function can work on either structured or unstructured dense point clouds. All you need
to do is confirm the automatically detected floor and ceiling planes and select the extraction
method (interiors or exteriors).

You can also set the Epsilon (point to plane distance - points further from this value will not
be considered belonging to the plane) and fusion factor (controls how segments are
generated, a higher value will yield a longer segment and less gaps) if you need further
control on the generation method.
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Click "Compute" to start the process. When done, blueprints (polylines) and surfaces
(surfaces) can be added in the workspace by clicking "Save to Workspace". All elements
can be found under the Drawing Elements Section.

· Make surface from control points

Surfaces can be generated by selecting control points. Simply select and add the desired
control points to the shape and click "OK" when ready.
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· Spot Height Map

This tool allows to create spot height maps on dense point clouds or meshes either using
the GCPs you have already placed or picking new control points.

All the control points you pick or take into account will display their elevation value instead
of the GCP name, and a new surface will be drawn while picking/importing the control
points. You can change the surface color map as well as the size of the height values. Once
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you click the OK button, you will generate both a new mesh and a group of new vertices
that will be listed in the Drawing Element section of the Project panel.

Tools - Scripting console

These functions are not available in 3DF Zephyr Lite and 3DF Zephyr Free.

You can use this scripting console to customize your own workflow up to a certain degree
of freedom using the Python scripting language.

The Python console has its own manual, especially because these functionality will be
extended with more bindings in the future.

To generate the Python Console manual, type zephyr.documentation() directly in the
console. A PDF will be generated on-the-fly with the available functionality, as well as some
python examples you can use.

Tools - Options

By clicking the wrench icon in the toolbar or the Tools menu you will access the Options
including 8 tabs: General, Appearance, Rendering, Cuda, Camera, Input, Names, and
System. From this window you can tweak and set Zephyr in appearance, functionality and
user experience. To simplify the options scrolling, a search tool is also available.
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· The General and Appearance tabs allow you to set the overall look and feel of the 3DF
Zephyr Window, including language, theme, font size and more. 

· The Rendering tab allows you to edit 3DF Zephyr graphic appearance. You can modify
the colors of several items ranging from the workspace to the grid and control points.

Among the most used settings:

- For the viewport, you can change its color with default and custom themes, and also
set a Skybox for your 3D model, either by selecting from the panoramic default images
(source: HDRI Haven) or by uploading your own panoramic pictures within the "Skies"
folder present in the 3DF Zephyr directory.
- For point clouds generated within 3DF Zephyr, you can change the graphic size of
individual points.
- For the cameras, you can edit at any time the alpha channel which is useful to set both
the images transparency and the size and color of cones detecting shots in three-
dimensional space.

· You can enable/disable CUDA, either globally or single cards, in the Cuda tab.

· The Camera tab allows you to set values for the camera movement parameters. Also
allows managing the connection with 3D devices.

https://hdrihaven.com/
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· The Input tab allows managing hotkeys bindings. 

· You can set the desired default names for control points, 3D and drawing elements in
the workspace in the Names tab.

· In the System tab, you can toggle (and customize) sleep hours, in which Zephyr will
automatically shut down the computer if all computations have finished as well as define
other system options.

The "Utilities" menu

From this menu you can launch the following Utilities:

3DF Masquerade

3DF Masquerade is the standalone external tool (included in all 3DF Zephyr versions) to
create masks to pair with the images to be processed in 3DF Zephyr. A mask is defined
as a specific selection of one (or more) images that allows to force zephyr to ignore the
corresponding part in a picture. The first time you run Masquerade useful tooltips will
appear on the screen that will teach you the interface basics.

You can find a complete tutorial (and video tutorial) about 3DF Masquerade at the URL
http://www.3dflow.net/en/technology/documents/3df-zephyr-tutorials/tutorial-use-masking-
tool/

You can load images by simply dragging and dropping them in the main window or from
the File menu.

The 3DF Masquerade interface is organized in five main areas:

1. Folder Navigator - browse the loaded images and shows their status - "(M)"
near the filename means that a mask has also been detected in the same directory.

2. Mask editor - shows the current image and the drawn mask
3. Toolbar - allows access to the masking tools
4. Top toolbar - allows quick access to save/load functions, undo/redo, rotate

image and show black and white mask functions
5. Command history - used to undo / redo commands in 3DF Masquerade.

http://www.3dflow.net/en/technology/documents/3df-zephyr-tutorials/tutorial-use-masking-tool/
http://www.3dflow.net/en/technology/documents/3df-zephyr-tutorials/tutorial-use-masking-tool/
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The Rectangle, Polygon and Lasso tools are very similar and most users should be
already familiar with them: to mask a certain area (the area you want to process) you can:

- drag a rectangle and click the "mask" button to mask the selected area

- use the left click button to add nodes to the polygon path (double-click to automatically
close the polygon) and click the "mask" button to mask the selected area

- drag the lasso and click the "mask" button to mask the selected area.

When the selection has been made, you should see a blue overlay, while when the mask is
being applied, you should see a red overlay.

You may also remove a mask subsection using the "remove mask" button.

Using these tools you can add and subtract different ares by keeping the left control/left
shift keyboard button pressed when doing an action. You may also undo actions using the
CTRL+Z shortcut or by using the command history.

You may also change the zoom value by using the scroll up/down mouse wheel; you may
also translate the current view by moving the mouse while the mouse wheel is kept pressed
down.

The silhouette tools (red stroke and blue stroke) can be also used to automatically compute
the silhouette of the subject by tracing the foreground element (red, which will be masked)
and the background element (blue, which won't be masked). You may also quickly swap the
foreground/background by using left shift + left click.

You can also delete strokes by dragging the cursor over it and right clicking while dragging.

This tools is very useful especially when the background has a very high contrast with
respect to the subject that you want to reconstruct.
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A gear shaped function allows you to automatically compute the next silhouette, very useful
especially when dealing with turntables. In this case you should consider accessing also
the "mask by color" function, useful especially when the background is uniform and in high
contrast with the subject.

You may also start the "autocompute" function using ENTER or the "autocompute all"
function using CTRL+ENTER.

The "turntable mode" will also compare the current image to the next one when using the
autocompute function to better draw the silhouette.

Finally, a tool that automatically removes the background, especially useful with controlled
scenarios (i.e., close range/turntable photogrammetry).

All masks are saved as .bim files and are loaded automatically by 3DF Zephyr if saved in
the same directory as the images (as long as you have also checked the "mask images"
button in the project wizard). You may import masks that have been generated outside 3DF
Masquerade into 3DF Zephyr using the _masked suffix.

GEOBIM (Revit plugin)

This function is not available in 3DF Zephyr Lite and 3DF Zephyr Free.

Using the geobim dialog in 3DF Zephyr you can enable the Revit plugin service that allows
for synchronization between the two programs.

Please note that this function is still experimental: you can download the plugin from
https://www.3dflow.net/3df-zephyr-plugins-download/3df-zephyr-geobim-revit-plugin/

After opening the dialog, you may select the desired elements in the window. Those items
will be synchronized in Revit after "Import" has been clicked from Revit, in the "Zephyr Add
in" Panel.

https://www.3dflow.net/3df-zephyr-plugins-download/3df-zephyr-geobim-revit-plugin/
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You may also decimate point clouds before those are being sent to Revit: this is advised
for point clouds composed by more than 2M points. You simply have to select the
"decimate point cloud option" and by specifying the desired amount of points to be kept.

Batch processing

This function is not available in 3DF Zephyr Lite and 3DF Zephyr Free.

The Batch processing window allows to schedule certain reconstruction jobs. Jobs must
be defined via XML files, and they must follow the pipeline workflow, at least partially (this
means that you can setup a job from the sparse point cloud generation to the texture mesh
generation, eventually stopping at any of the intermediate step, but  you can not define a
job that starts after a camera orientation).

The xml files must be defined in this format:

<?xml version="1.0"?>
<Settings>

<Category name="Batch">
<Entry key="InputDirectory" value="ImagesInputPath">
<Entry key="OutputDirectory" value="OutputPath/>
<Entry key="Phase" value="SamanthaStereo"/>
<Entry key="SamanthaPresetCategory" value="Urban"/>
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<Entry key="SamanthaPresetName" value="Fast"/>
<Entry key="StereoPresetCategory" value="Urban"/>
<Entry key="StereoPresetName" value="1_Default"/>
<Entry key="SurfacePresetCategory" value="Urban"/>
<Entry key="SurfacePresetName" value="0_Fast"/>

</Category>
</Settings>

It is also possible to use the custom parameters directly in the XML. A description of the
categories and the parameters is available when selecting "Custom" during the
reconstruction wizards or by selecting the properties (with the right click) of an element
reconstructed within the workspace. After scheduling one or more job, they will be listed in
the interface, from where you'll be able to start the batch operations.

Run benchmark

The Benchmark tool allows to measure the performance of a machine in order to figure out
if it is suitable for running a 3D reconstruction using 3DF Zephyr.
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The dialog displays your pc specs, and after you clicked on the "Run benchmark" option,
you will see the running times for each Zephyr phase and the overall running times.

It's possible to save your benchmark results as an image and text file, or you can
anonymously send and share them on the 3Dflow website. 

Please note that this function is still experimental.

Camera Calibration Manager

The camera calibration manager allows the user to store camera calibrations on the
current system. Although 3DF Zephyr is completely autocalibrated, it is useful to start from
a calibrated device when possible.
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You can import a calibration from the current workspace (if a successful reconstruction has
been completed) or you can load it from our online database by simply feeding a JPG (with
EXIF data). This service is completely free and anonymous.

You can also import and export camera calibrations from/to XML.

This tool is especially useful for computers working offline, as Zephyr will not be able to
check 3Dflow's online database for pre-calibrations.

Preset Manager

The Preset Manager tool allows the user to manage custom presets for processing.
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You can import presets from the current workspace (if available) or you can create your
own custom one by right clicking the desired category and selecting "Add preset".

If you wish to quickly share a preset with a colleague or a friend, you may also select
"Upload preset" by right clicking a previously generated preset. Your preset will be
uploaded and stored anonymously to our server and an ID string will be shown on screen.
You can then select "Import preset from online database" using the same ID. Please
note that anybody with the ID will be able to download it: this service is completely free and
anonymous and 3Dflow does not guarantee persistence of uploaded presets.

You can export your presets as an .xml file if needed.

Images

Utilities that apply to images files are all grouped under this sub-menu.

Image quality index

The Image Quality Index tool shows a numeric value (and visually in the full version of
Zephyr) the quality of the input pictures. You can simply drag and drop the pictures into the
quality index window, and the score will be automatically computed. Higher score means
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higher quality. Please note that this score is computed per picture: it does not use any 3D
information or of workspace information - this will simply compute which areas of the
picture are well in focus and potentially with a high density of keypoints. A high-score
picture does not automatically means that a picture has been shot correctly, however a low-
score picture should be discarded (in green are shown the better areas). Double click each
line to open the visual mode.

Extract MPO files

This utility allows to extract MPO files. Simply select the MPO files you need to extract by
clicking the "+" sign and click OK to start the MPO extraction process.

Image conversion

This tool allows to convert pictures to .jpeg, .tiff, .png formats.
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It also possible to define the color space as well as to apply Gamma correction and to
remove pictures distortion (the latter option requires a calibration file of the camera
equipment to be loaded).

Decompose equirectangular panoramas

3DF Zephyr can deal with any 360° images by decomposing each picture into 6 pinhole
like cameras using the utility "Decompose equirectangular panoramas". The images
then will be treated normally.
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The tool asks to select at least one picture as well as to specify a destination folder.
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8 panoramas and the resultant pictures after the "Decompose equirectangular panoramas" tool has been
exploited

You can select which side of the equirectangular cameras will be extracted by checking the
appropriate side. Since v3.700, 3DF Zephyr will optimize the extracted sides and use them
as constraints during the Structure from Motion phase as long as the filenames of the
extracted cameras will keep the suffixes in the filename ( _left, _right, etc.): Zephyr will
however ask for confirmation in the project wizard.

DEM viewer and elevation profile

These functions are not available in 3DF Zephyr Lite and 3DF Zephyr Free.

The DEM viewer utility allows viewing DSM and DTM files directly from the Zephyr UI. 

Please note that you are supposed to generate an orthophoto before running DEM
generation. To do so, simply click on Workflow > Generate True Orthophoto from
Mesh and follow the wizard for the orthophoto generation.

The DEM viewer utility can be used to:

· load DSM / DTM and multi-tiled DSM/DTM files (even those not related to the project
you are working on) by clicking on File > Open from file or Open from workspace;

· load contour lines on DSM / DTM  if they have been previously generated in 3DF
Zephyr, by clicking on View > Show polylines; 

· export DSM /DTM as an image (available formats: .png, .jpg, .bmp) by clicking on File
> Export color image;

· generate elevation profiles;
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DSM/DTM files and orthophotos are loaded together automatically, provided they are
located in the same directory. Here is an example of contour lines, DEM and orthophoto
mixed together inside DEM viewer:

Elevation profile generation

You can generate elevation profiles in the DEM Viewer utility provided that you have
already created an orthophoto/DSM/DTM (not necessarily related to the project you are
working on).

Simply click on the Elevation Profile icon and pick at least two points on the DSM/DTM.
Double-click to add the last point and open the setup page. You will notice both the quota
and progressive entries are already listed into the chart. 
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In the setup page you can:

 - define the step size and number (distance between each quota/progressive value) in
meters;

 - add/delete/edit/move up/move down your quota, progressive, latitude or longitude entries
clicking the related button;

Click Next to select the profile you want to generate from the drop-down menu on the
preview page, and the elevation profile will be automatically created.
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You can click the Export button to select the desired format (.pdf, .dxf) as well as the page
size and resolution of the .pdf layout.

*TIPS*

 -  you can generate an elevation profile from a polyline you have already drawn by clicking
Tools > Sections and Contour lines > Elevation profile from drawing elements  and
selecting the desired drawing element using the Add button in the Setup page.

 - you can generate an elevation profile from a group of control points you have previously
placed on the 3D model by clicking Tools > Lines extraction > make polyline from
control points and continuing the above workflow to generate an elevation profile from a
polyline.

You can also calculate distances on the DSM/DTM by clicking on the Enable measure
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tool icon and picking two points on it.

The corresponding distance (meters) will be displayed next to the drawn polyline (see the
image below).

Launch camera calibration

The Launch camera calibration utility opens 3DF Lapyx, with an easy to use wizard to
compute the camera calibration. Follow the on screen instruction if you wish to precalibrate
your camera. You won't need to print anything: the pattern will be shown on the screen and
that is what you need to photograph.

Bubble view extraction

This utility allows for extracting bubble views from one or more laser scans. You can choose
the image format of the output (jpeg, png) and export the XMPs and the image masks as
well.

Multispectral

These functions are not available in 3DF Zephyr Lite and 3DF Zephyr Free.

Radiometric calibration and multispectral viewer are accessed from this menu, while
multispectral orthophoto composition is directly managed from the Orthophoto generation
function in the Workflow menu.

Launch radiometric calibration

These functions are not available in 3DF Zephyr Lite and 3DF Zephyr Free.

Although not mandatory for processing, it is advisable to take pictures to calibrate your
multispectral camera before the actual flight. With this tool, those images can be used for
the calibration process.
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3DF Zephyr currently supports the MicaSense RedEdge sensor and thermal images taken
with DJI devices.

Open the Radiometric calibration wizard from the menu: Utilities > Multispectral >
Launch Radiometric Calibration wizard

Image Selection
In this page, it's possible to select the input and output directories from the wizard.

Panel Selection

In order to enable the "next" button, you then must select any image that views the
calibration panel. 3DF Zephyr will automatically find the panel images for each band. After
clicking the next button, you will be asked to draw a square over the calibration panel on
each of the available bands.
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Once you have drawn the square over all the detected bands, the "Run Calibration"
button will be clickable. Click it in order to proceed with the calibration process. Once the
process is complete, a summary will be shown, where you'll be able to click any image in
order to see the result of the calibration.

Results
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Multispectral viewer

Similarly to the DEM viewer, the Multispectral Viewer allows to view TIFF files and make
measurements over multispectral images.

Other
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System info

Opens the system monitoring panel. you can toggle the desired information by clicking the
desired item shown in the list on the right side of this panel.

DSLR remote shooting

This utility requires the download and installation of the DSLR remote shooting plugin
available from http://www.3dflow.net/remote-dslr-sync-shooting-plugin-download-3df-
zephyr/

Please note that this utility is still to be considered in beta. At the moment of writing, this
plugin only supports Canon DSLR cameras.

In order to launch this utility, you must first install the plugin: once you have done so, turn on
your cameras, connect them to your PC and then launch the utility: the utility will not detect
newly connected cameras so you must restart the utility in case you need to connect
additional cameras.

Once you have selected the output directory, you will see the detected cameras in the
interface as a list : each row corresponds to a camera. You may change ISO, Av and Tv
settings physically on a target camera (you will see the changes happen in real time in the
cameras list) and then use the appropriate "propagate" button to propagate those settings
to other cameras.

Please note that other settings (white balance, etc.) have to be setup manually on each
camera.

You may use the appropriate "Take shot"  to take a picture from a specific camera or use

http://www.3dflow.net/remote-dslr-sync-shooting-plugin-download-3df-zephyr/
http://www.3dflow.net/remote-dslr-sync-shooting-plugin-download-3df-zephyr/
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the "take picture on all cameras button": please note that in this last case, there is a delay
(about 100ms) for each connected camera.

If you need synchronization, you should trigger simultaneously the cameras, for example
with a radio control. 

Notes about the physical setup: although theoretically Zephyr could handle a number of
cameras that is limited by the physical USB ports available, it is advised to limit to 16
cameras for notebooks and 32 for desktops. Please also remember that USB cables
should not be longer than 5m and if possible avoid using USB hubs.

3DF Zephyr Lite has a hard limit of two cameras.

Handle laser scanner point clouds

Since version 3.0, Zephyr supports laser scan native format files.

In order to install native laser scan support, you have to install the free plugin for the desired
format from http://www.3dflow.net/native-laser-scanner-support-plugin-3df-zephyr-
download/

3DF Zephyr Lite and Free can open (as viewer) laser scan format files as well, while the full
version of 3DF Zephyr also have the option to import those file in the workspace.

3DF Zephyr supports the following native format files from the following laser scan device
manufacturers:

· Faro (.fls, .flw)
· RIEGL (.rdbx)
· Dot Product (.dp)
· Z+F (.zfs)
· Recap (.rcp)

Custom shaders

Since verson 3.500, a new shading system has been employed that allows advanced
users to write and customize the shading used by Zephyr.

http://www.3dflow.net/native-laser-scanner-support-plugin-3df-zephyr-download/
http://www.3dflow.net/native-laser-scanner-support-plugin-3df-zephyr-download/
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You can select the shader using the  button in the toolbar.

You can then switch 3DF Zephyr default shader or write your own. You can find a test
shader installed alongside Zephyr.

Troubleshooting

3DF Zephyr is a very complex software: in this section, you'll find some general
troubleshooting hints as well as some frequently asked questions.

First ad foremost, please remember that you can contact the tech support at the email
address support@3dflow.net or on the forum at the URL http://www.3dflow.net/forums/

When contacting the tech support, please try to have these information ready:

· Operating System and Hardware specifications

It's very helpful for us to know which platform Zephyr is running on. Please let us know, at a
minimum, your operating system as well as its hardware specs (at least CPU, RAM and
Video Card)

· Log files

Zephyr logs a lot helpful information on text files that are saved in your %appdata%
directory - you may eaccess this directly easily from the Zephyr options menu by selection
the "Application" tab and then clicking on the  "Open Log Folder" directory.

mailto:support@3dflow.net
http://www.3dflow.net/forums/
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Make sure to attach the relevant log files in order to help us pinpoint the cause of your
issue.

After contacting us, you will be contacted by our tech support.

FAQs

Some common questions can be answered here:

I get a numeric error message on startup and Zephyr cannot be activated, what
can I do?

Make sure that you are connected to the internet when activating your product and that the
time and date on your system are correct. If you are using a trial key, please remember to
activate it within 14 days of generation.

Zephyr can't write on hard disk, what can I do?

Make sure that no other software is preventing Zephyr to access the file system. In any
case, you may specific an arbitrary temporary directory from the options menu.

Can I install 3DF Zephyr on more than one computer with one license?

You can uninstall and install 3DF Zephyr as many times and on as many computers as you
need. The only requirement is that there can be only one simultaneously installed copy of
Zephyr on your computers. If your license allows you more than one installation, than that
limitation applies.
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I'm experiencing problems/crashes with 3DF Zephyr. What should I do?

3DF Zephyr is a complex software, so it's hard to tell without further information. Post on
the forums or send us an email, describing your problem and don't forget to attach the logs!

How do I use the developer console?

Please consider that this feature is for support only, things will break if not used correctly.
The console uses LUA 5.3.1 but no external dependencies are needed.

Which is the difference between Constraints and Control points?

Let's think about an aerial capture where you have both coordinates taken by a GPS
system on drone and some coordinates on the ground taken with a total station for
instance.

After you have placed your points in Zephyr, you can choose which points must be the
constraints, namely the points you are confident (of their accuracy) the most, and which
points will be taken into account as simple references.

The first group will be the points taken on ground with the total station since their accuracy
is definitely higher than GPS coordinates taken by the GPS system on drone, that
represent the second group.

How can I ignore GPS data before performing my 3D reconstruction?

Simply click on Tools > Option > Application and disable "Allow Structure from Motion to
use GPS information from cameras" option.

Which is the difference between structured objects and unstructured objects?

An object (photogrammetric clouds or scans) can be named "structured" when it includes
the origin's point of its element (laser scanner devices rather than pictures). Native laser
scanning file formats usually include the origin's point as well as other formats such as the
E57 one. Other formats such as the .las one never provide the origin's point.

Performance tweaking

Please always make sure that Zephyr is running on a computer with the latest NVIDIA and
CUDA software updates (when possible).

3DF Zephyr takes advantage of the CUDA technology, so running Zephyr on a machine
with one (or more!) NVIDIA cards is strongly advised. If you are considering an hardware
update, make sure to consider:

- adding a SSD drive if you don't own one already
- adding an NVIDIA card
- adding more ram (depending on the size of your datasets)
- using a faster CPU

Disable coloring if you don't need it
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If you are only interested in getting a textured model, there is no need for the intermediate
steps to compute the color in the point cloud and mesh generation. You can disable
coloring from the general application options dialog. You may also right click an element
and select "update colors" if you wish to compute them for a specific one.

Use a unified and persistent cache directory

You can also use a unified and persistent cache directory. Please note that this is not the
default behaviour, as it will use a lot of available space and you will have to manually clean
it.

We strongly suggest you run 3DF Zephyr on a workstation that has a SSD drive. If your
windows installation is on a mechanical drive and you have another SSD drive, you may
also consider switching the temporary directory on that drive.

Running Zephyr via remote desktop

Zephyr requires OpenGL 1.4 in order to render its interface: please keep in mnd this when
controlling Zephyr via remote desktop (both from a physical machine or from a virtual
machine).

Microsoft RDP (until Windows Server 2019) does not support OpenGL 1.4 - you
must use a remote desktop client that supports OpenGL 1.4, for example Splashtop or
Hamachi Logmein if your Microsoft RDP version does not support OpenGL 1.4.

Please also note that even virtual machines must have their correct drivers installed. Make
sure that you have your graphics drivers up to date. In some rare cases - i.e. when a video
card has just arrived on the market - you may need to install the developers NVIDIA driver
available at the URL https://developer.nvidia.com/cuda-downloads until the newer version
of Zephyr takes care of that.

https://developer.nvidia.com/cuda-downloads
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